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Welcome to PDF Creator Plus

Thank you for choosing PDF Creator Plus 6.0, a powerful application that lets you easily create PDF files,
and TIFF, BMP or JPG images from any document. Some of the main features are:

Quickly preview and create PDF files from any Windows® application that can print

Easily assemble documents from different sources into a single PDF file

Annotate pages with notes or special instructions 

Rearrange and rotate pages

Add cover pages, headers and footers

Delete unwanted pages

Save the project for working on later and sharing with others

Print to any installed printer

Export to any of the following formats:

Searchable and secure Adobe PDF documents

TIFF images

JPEG images

Windows Bitmaps (BMP)

Enhanced Metafiles (EMF)
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Legal Notices

PDF Creator Plus 6.0

Copyright © 2004 - 2012 by PEERNET Inc. All rights reserved.

PEERNET is a registered trademark of PEERNET Incorporated. Microsoft and Windows are registered
trademarks of Microsoft Corporation. All other trademarks and registered trademarks are the properties of
their respective holders.

PEERNET Inc.
18 Deakin Street 
Suite 208
Ottawa, Ontario 
K2E 8B7

Information in this document is accurate up to the time of publication, but does not necessarily reflect
enhancements made to PEERNET Inc.’s products, which are released without notice. The software
described in this document is furnished under a license agreement. It is against the law to copy the
software onto any medium, or to use the software for any purpose, except as specifically allowed in the
license agreement. No part of this help system may be reproduced or transmitted in any form or by any
means, electronic or mechanical, for any purpose other than the licensed operator’s personal use, without
the express written permission of PEERNET Inc.
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System Requirements

PDF Creator Plus 6.0 can be installed and run on any of the operating systems listed below. PEERNET
Inc. recommends running this application on systems with 512 MB or higher RAM, and an Intel®
Pentium® III or higher processor.

Supported Operating Systems

Both 32-bit and 64-bit operating systems are supported where applicable

Microsoft® Windows 8 

Microsoft® Windows Server 2012

Microsoft® Windows 7

Microsoft® Windows Server 2008 R2

Microsoft® Vista 

Microsoft® Windows 2008 Server

Microsoft® Windows 2003 Server

Microsoft® Windows XP

Microsoft® Windows 2000

Citrix® MetaFrame®
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Typographic Conventions

Menu commands in this User Guide are displayed with a hyphen (-) separating the menu name and the
command. For example, ‘Click File – Open’ instructs you to select the File menu, then select the
Open command while ‘Click Edit – Copy’ instructs you to select the Edit menu, then select the Copy
command.

Keyboard conventions

The following conventions are used in this User Guide to describe keystrokes and key combinations:

Key names appear in capital letters and are referred to by their names only (e.g. without the word
‘key’). For example, ‘Press ENTER’ instructs you to press the ‘ENTER’ key while ‘Press CTRL’
instructs you to press the ‘CTRL’ key.

Two key names on either side of a plus sign (+) instruct you to press and hold the first key while
pressing the second. For example, ‘Press CTRL + O’ instructs you to press and hold the ‘CTRL’
key while pressing the ‘O’ key.

Terminology conventions

The following terms are used throughout this User Guide:

Term Action / Description

Select
Highlight an item using the left mouse button or the appropriate
keyboard commands.

Point
Position the mouse pointer so that its tip rests on what you want to
point to on the screen.

Click
Point to an item with the mouse pointer, then press and immediately
release the left mouse button without moving the mouse.

Right-click
Point to an item with the mouse pointer, then press and immediately
release the right mouse button without moving the mouse.

Double-click
Point to an item with the mouse pointer, then press the left mouse
button twice in rapid succession without moving the mouse.

Drag
Point to an item with the mouse pointer, then press and hold the left
mouse button while you move the mouse. When you have moved the
item to its desired position, release the mouse button.
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Activating PDF Creator Plus

PDF Creator Plus is installed as a 30-day trial by default. When the install is complete, the Activation
Status dialog is automatically displayed. 

You do not need a serial number to evaluate PDF Creator Plus. Click the button labeled "I want to
continue evaluating" to activate the trial version of the product for 30 days.

The progress bar at the bottom displays how many days you have left in your trial. While in evaluation
mode, the Activation Status dialog is displayed only once every 24 hours.

At any point in your trial period, you can go directly to our on-line store by clicking the button labeled "I do
not have a serial number and want to purchase." to purchase the product.

If you have purchased a copy of PDF Creator Plus, you will receive a serial number as part of your order
confirmation. Upon receipt of your serial number, follow the steps outlined starting with Launching the
Activation Wizard to activate your product.
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Launching the Activation Status Dialog

The Activation Status dialog is used to activate a trial version of the software, or to display your
current license status if the product has already been activated.

When you are running in trial mode, the Activation Status dialog is displayed each time PDF Creator
Plus is launched. To launch the application select All Programs – PDF Creator Plus 6.0  – PDF
Creator Plus 6.0 from the Windows Start menu.

If the application is already running, you can access the Activation Status dialog from the Help -
License... menu item.

The Activation Status dialog displays different options when your trial period has expired than when
you are still in trial mode.

If you have time remaining in your trial...

If you still have time remaining in your trial period, you can

choose to activate the product with your purchased serial number

go to our on-line store to purchase the product

continue to evaluate the product

To begin the activation process now, select the "I have a serial number and want to activate my copy"
button. This will launch the Activation Wizard, which will guide you step-by-step through the
activation process.

I have a serial number and want to activate my copy - Select this option if you have your
serial number and want to activate your product. When the product is activated, the evaluation
watermark is no longer placed on created files.

I do not have a serial number and want to purchase - Selecting this option will take you to
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Launching the Activation Status Dialog

our on-line store where the product can be purchased. Once purchased, an order confirmation
notification containing your serial number will be sent to you by email.

I want to continue evaluating - Selecting this option allows you to evaluate the product. An
evaluation watermark will be placed on all files created.

If your trial period has expired...

If your trial period has expired, you can only activate the product with your purchased serial number or
go to our on-line store to purchase the product.

To begin the activation process now, select the "I have a serial number and want to activate my copy"
button. This will launch the Activation Wizard, which will guide you step-by-step through the
activation process.

I have a serial number and want to activate my copy - Select this option if you have your
serial number and want to activate your product.When the product is activated, the evaluation
watermark is no longer placed on created files.

I do not have a serial number and want to purchase - Selecting this option will take you to
our on-line store where the product can be purchased. Once purchased, an order confirmation
notification containing your serial number will be sent to you by email.
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Entering Your Serial Number

To activate your product you need to enter in the serial number that was included with your order
confirmation email.

Enter the serial number into the appropriate boxes. A section of your serial number has already been filled
in; you only need to fill in the rest. You can also copy the entire serial number from your email and paste it
into the dialog box using the clipboard icon to the right of the serial number fields. 

Entering Serial Numbers:

The astericks (*) in the serial number field are placeholders and will be
overwritten as you type in the serial number.

The serial number is case sensitive and it is important to type the serial number
exactly as it is received. Be sure not to leave any spaces before or after the serial
number when typing or pasting, and note that the serial number ends with a
series of hexadecimal characters (0-9,A-F).

Activating without an internet connection

If you are having difficulty connecting to the internet, or do not want to activate over the internet, you
can choose to manually activate the product by clicking the Enable Manual Activation checkbox on this
screen.

Manual activation does not require an Internet connection on the computer the software is installed on,
but it does require that you have the ability to email an encrypted file to us to authenticate.

We will return the authenticated file to you, which you then import using the Activation Wizard to
complete the activation process. These files are processed by PEERNET’s technical staff from 09h00
to 17h00, Monday to Friday, Eastern Standard Time.

When activating over the internet, the Activation Wizard will attempt to validate an internet
connection, and will prompt with the choice to manually activate it if it cannot connect.
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Entering Your Serial Number

Click the Cancel button to begin the manual activation process, or the Retry button to try connecting
to the internet again.

Note:

If you suspect your firewall or anti-virus software has blocked the connection,
adjust your firewall or anti-virus software and click Retry.

Click the Next button to continue.

In a wizard dialog, you move from screen to screen using the
Next and Back buttons found at the bottom right of the
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Entering Your User Information

The next screen asks for your contact information. If possible, your Name and Organization information is
automatically picked up from your system settings. The information in these fields can be changed if
required.

Customer Privacy: 

You cannot continue if either the Name or the Email Address field is left blank.
Email addresses entered here are only used by PEERNET to notify you of updates
to your product or other products that may interest you. We will never rent or sell
our customer's and client's information to third parties.

Click the Next button to continue.

In a wizard dialog, you move from screen to screen using the
Next and Back buttons found at the bottom right of the
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Validating Your Information

This screen summarizes the information entered in the previous screens. The Back button can be used
to return to the previous screens and change any information if needed.

If you are activating your product over the internet

If you are activating over the internet, skip the next section and go to Activation status results.

If you are activating manually (no internet connection)

If you are using manual activation, you will be taken to the manual activation export screen.

Click the Next button to continue.

In a wizard dialog, you move from screen to screen using the
Next and Back buttons found at the bottom right of the
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Manually Activating the Product

In most cases, you will not have to activate your product manually. This only happens when PDF Creator
Plus is installed on a computer that has no access to the internet, or the computer is configured such that
the user cannot access the internet. This can also happen if a firewall program or anti-virus software
blocks our attempt to connect with our license server.

If you do have to activate manually, you will need to follow the steps below.

1. Use the Activation Wizard create the encrypted file, PNPRodID.txt.

2. Email the file to to peernet@peernet.com to be activated. For computers with no email capability,
you can save the file to a shared network drive, or use an external storage device such as a USB
flash drive (also known as thumb drives), or a MicroSD storage card to copy the file to a computer
with email capabilities.

3. A file named PNProdAU.txt will be emailed back to you. Copy this file back to the computer
where PDF Creator Plus is installed and restart the Activation Wizard to complete the license
activation.

Exporting the PNProdID.txt file

To create the file click the "Create the PNPRodID.txt product identification file" button in the middle
of the screen.

A save dialog box will appear prompting you to choose where to save the PNProdID.txt product
identification file. Save this file in an easy to remember location, like your Desktop or your
Documents folder.

mailto:peernet@peernet.com


PDF Creator Plus 6.0

13 Activating PDF Creator Plus

Manually Activating the Product

You need to email this file to peernet@peernet.com. For computers with no email capability, you can
save the file to a shared network drive, or use an external storage device such as a USB flash drive
or a MicroSD storage card to copy the file to another computer.

Importing the PNProdAU.txt file

When you have received the product authentication file PNProdAU.txt from PEERNET Inc., you will
need save the file in an easy to remember location, like your Desktop or your Documents folder. If
you need to move the authentication file back to the computer where PDF Creator Plus is installed,
do so now. 

On the computer where PDF Creator Plus is installed, restart the Activation Wizard by following
the steps outlined in Launching the Activation Status dialog. The Activation Wizard will
automatically start at the import screen.

Press the "Import the PNProdAU.txt product authentication file" button in the middle of the screen.

mailto:peernet@peernet.com
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A browse dialog box will appear. Locate where you saved the PNProdAU.txt file you received from
PEERNET and click the Open button to import the file.

The authentication file is verified and you are automatically moved to the Activation Status Results
screen. 
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Activation Status Results

This screen displays your activation status. Once the product is successfully activated, the Activation
Status field will display your status as Activated.

If an error occurred during activation it is displayed in the Activation Status field, such as the following
error message that occurs if you have exceeded your license activations.

When you have used all your license activations, you will not be able to use the product on this computer
until additional activations have been purchased.

1. Close the Activation Wizard and restart the activation process as explained in the section
Launching the Activation Status dialog.

2. Choose "I do not have a serial number and want to purchase" to go to our on-line store where
addition licenses can be purchased.
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Activation Status Results

If you are moving your license to a new computer, or if you have to re-install the
software on your computer due to a crash, please contact PEERNET Sales at 
peernet@peernet.com with your current serial number for assistance.

mailto:peernet@peernet.com
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Viewing Your Activation Status

To view your activation status, select All Programs – PDF Creator Plus 6.0  – PDF Creator
Plus 6.0 from the Windows Start menu to launch the PDF Creator Plus application.

When you are running in trial mode, the Activation Status dialog is displayed each time PDF Creator
Plus is launched.

If you have activated the application. you can access the Activation Status dialog from the Help -
License... menu item. In the dialog the Status field will display Activated and your serial number,
license type, name, organization and email address are also displayed.



18

PDF Creator Plus 6.0

Running and Navigating PDF Creator Plus

 

Running and Navigating PDF Creator Plus

The PDF Creator Plus user interface consists of a menu bar, four toolbars, a task window, a design
window containing a navigation view and a page view, and a status bar. You can customize the locations
and appearance of the toolbars, so the interface may not always appear the same.

Explore the User Interface

Application Menu Bar

Application Toolbars

Design Window

Application Status Bar
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Application Menu Bar

The application menu bar provides access to both standard and application-specific commands. 

There are seven application menus: File, Edit, View, Page, Layout, Annotation, and Help. Each
menu contains commands specific to one area of the application. For example, the File menu contains the
following commands:

Each menu contains a listing of commands, the icons for any related toolbar button, plus the key
combinations for any available shortcut keys. See the Command reference section in the appendix for a
complete listing of the commands available in the application menu bar.
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Application Toolbars

The PDF Creator Plus application toolbars provide quick access to frequently used commands. To see a
brief description of a toolbar button’s purpose, hover over the toolbar button with the mouse until a small
popup window appears.

There are four default toolbars:

Standard:

View:

Annotations:

Layout:

Only the Standard, View and Annotations toolbars are visible by default. The Standard and
View toolbars are docked at the top of the application; the Annotations toolbar is docked at the
bottom just above the status bar.

To display the Layout toolbar, click the View – Toolbars - Layout menu item. You can also change
the position of the toolbars by dragging them with the mouse around the edges of the application. They
can be docked at the top, left, right or bottom sides of the application.

If you hover your mouse pointer over a toolbar button, a tool tip will appear containing the name or
function of that button. In addition, the status bar message area will display a message indicating the
function of the toolbar button.

See the Appendix at the end of this guide for a complete listing of the commands available in the
application toolbars, as well as how to customize the toolbars.
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Task Window

The task window runs along the top of the application, just below the toolbars. It contains easy to access
buttons for creating common files types from within the PDF Creator Plus application. Selecting any of the
buttons will launch the Create File dialog, allowing you to create a file of that type.
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Design Window

The PDF Creator Plus design window is split into two panes.

The left pane, or Navigation View, consists of a Thumbnails tab that displays a small preview, or
thumbnail, of each page in the project and an Outline tab that displays any headings and bookmarks
contained in the project.

The right pane, or Page View, displays the contents of the current page. It is used to annotate the
currently selected page using the annotation tools.

  Productivity Tips - Changing Views

You can hide the Navigation View by clicking View – One Page in the application
menu, or the Page View by clicking one of View – Thumbnails or View - Outline in
the application menu.

You can return to the dual display of Page View and the Navigation View by clicking
View – Page and Thumbnails or View – Page and Outline in the application
menu.

These options are also available on the Standard toolbar. By default, both the Page View
and the Navigation View are visible.

Changing View Size
You can change the size of either of the Navigation View or Page View by moving the gray divider
bar in the middle to the left or right. Position the mouse over the gray bar between the two panes - when
the cursor changes as shown below, click and hold the left mouse button to drag the divider bar to the left
or right.
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Navigation View

The Navigation View is made up of two pages of information – Thumbnails and Outline. Each
page is accessible by clicking the respective tab in the upper left corner of the pane.

Navigation View Tab Description

The Thumbnails tab contains a thumbnail of each page in the
project. You can use this view to easily move between the pages
within a project simply by clicking on the thumbnail in the view. It is
also used to arrange the pages within the project. The pages may
be reordered, deleted, copied or rotated. In addition, new pages
may be inserted or imported into the project.

The Outline tab displays the headings and bookmarks in the
project. Headings and bookmarks will normally be created using
the PEERNET Save as PDF command from within Microsoft
Word, but they can also be created manually using the 
Bookmark and the Hyperlink annotation tools.

Page View

The Page View is used to annotate the currently selected page using the annotation tools available in
the annotation toolbar.

Available annotation tools include a text object, a bookmark object, a hyperlink object and various other
shape objects such as lines, ellipses, rectangles and polygons.See Annotating Pages for more
information on adding annotations to your pages.
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Application status bar

The PDF Creator Plus status bar at the bottom of the application displays convenient help messages and
information about the project and the current page.

You can hide the displayed status bar by clicking View - Status Bar in the application menu.

The application status bar shows the following:

a help message or status message

the zoom level of the Page View

the size of the page in the Page View or the selected page in the Thumbnail View

the number of files currently being combined into one PDF Creator Plus project

the total number of pages currently in the project
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Zooming pages

You can select the zoom, or magnification level at which the pages are viewed.The zoom level can be
set from 1% to 1200%. Several common magnification levels are predefined for you. You can also zoom
in on specific areas of your pages using the Zoom to Selected Area command.

  Productivity Tips - Changing Zoom

To quickly change the zoom level, use the Zoom control on the View toolbar to choose a
magnification level, one of the zoom modes or to type in a custom zoom.

Use the Zoom In  or Zoom Out  toolbar buttons on either side of the Zoom
control on the View toolbar to increase or decrease the zoom level.

You can also change the zoom level from the View - Zoom menu and choose from the options in the
popup menu.
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Predefined Zoom Modes

Zoom Mode Icon Description

Best Fit The page is zoomed so that the entire page fits in the
right hand pane, or page view window.

Fit to Width The page is zoomed so that the entire page width is
visible in the right hand pane, or page view window

Fit to Height The page is zoomed so that the entire page height is
visible in the right hand pane, or page view window.

Zoom to Selected Area Allows you to select a specific area of your page to
zoom in to.

Zooming into a Selected Area

1. To zoom into a selected area, go to the View menu, select Zoom, then select Zoom to

Selected Area. You can also select the Zoom to Selected Area  button on the View
toolbar. The cursor will change to a small magnifying glass.

2. Move the magnifying glass cursor over to the area you wish to zoom in to. Click and hold the left
mouse button while you drag a rectangle around the area to zoom in to.

3. Release the mouse when you have outlined the area you want. The page will be zoomed to the
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Zooming pages

area you outlined.
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The PDF Creator Plus 6.0 Printer

There are two components to PDF Creator Plus:

the PDF Creator Plus application interface

the PDF Creator Plus 6.0 printer driver.

You use the PDF Creator Plus 6.0 printer driver to create PDF Creator Plus projects from within any
application that contains a Print command. For example, you could open a document in Microsoft®
Word, then use the PDF Creator Plus 6.0 printer driver to send that document to PDF Creator Plus. 

The PDF Creator Plus 6.0 printer driver works like any other printer you have installed on your system - it
appears in your Printers folder and is available anytime you have an option to print a file. The only
difference is that instead of creating a paper copy of the file, a digital copy is sent to the PDF Creator Plus
application.

Using the PDF Creator Plus 6.0 Printer Driver

Creating a New Project Using the PDF Creator Plus 6.0 Printer

Add Pages to a Project Using the PDF Creator Plus 6.0 Printer

PDF Creator Plus 6.0 Printer Properties
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Creating a New Project Using the PDF Creator Plus 6.0 Printer

With PDF Creator Plus you create PDF files by first printing the desired document to to the PDF Creator
Plus 6.0 printer driver from any Windows application.

1. Open the file you want to send to PDF Creator Plus. For example. if you want to send a
Microsoft® Word document you will need to open the document in Microsoft® Word.

2. Click File - Print (or use the application-specific Print command).

3. Select PDF Creator Plus 6.0 as the name of your printer.

4. Set any print properties as desired and click OK or Print to print the document.

5. When the pages have been printed the application interface will launch displaying the pages of
your document. 

From here, you can then work with the pages PDF Creator Plus project. For example, you can insert,
delete, rearrange, rotate, and add annotations to the pages of the file. If you want to add pages from
another document follow the steps in Add Pages to a Project Using the Printer Driver.

When you are done you can save the file to work with later, print the file to any installed printer, or create
a searchable Adobe® PDF document, a TIFF image, a JPEG image, a Bitmap image, or
an Enhanced Metafile.
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Add Pages to a Project Using the PDF Creator Plus 6.0 Printer

You can also use the PDF Creator Plus print driver to add further content to a currently open project. For
example, you could use the PDF Creator Plus 6.0 printer driver to convert documents in Microsoft® Word,
Excel, PowerPoint®, Adobe® PDF and any other applications into one single PDF Creator Plus project.

1. Launch the application whose file you want to send to PDF Creator Plus.

2.  Click File - Print (or use the application-specific Print command).

3. Select PDF Creator Plus 6.0 as the name of your printer.

4. Set any print properties as desired.

5. Click OK.

6. After you click OK, the Incoming Document window will open for you to specify where the
content should be added to the current project. If you are merging multiple files together into a
single PDF file, choose the Append the pages to the end of the project option. You can optionally
insert the pages anywhere in the current list of pages, or discard any pages you have printed and
create an entirely new project.

If you do not want the Incoming Document window to display for the rest of the current session (the
time period when this instance of PDF Creator Plus application is open), you can enable the Do not show
this prompt for the rest of the session option.

If you do not want the Incoming Document window to display again, you can enable the Do not show
this prompt again option. The next time you add pages to this project, the dialog will not display and the
Page Option last chosen will be used to determine where to add the pages.

If you have turned off the display of the Incoming Document window, it can be turned back on, or the Page
Options changed as follows:

1) Click Edit - Application Preferences in the application menu

2) On the Prompting Defaults tab

a) change the Page Options as needed to modify how the pages are added to open projects

b) uncheck the Do not show this prompt again or Do not show this prompt for the rest of the
session as needed to enable the dialog display again.
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Paper/Output

Paper size - used to set the size of the pages printed. Depending on your regional settings this
normally defaults to Letter (or A4 for Europe and the UK). Click the down arrowto the left will display a
list of paper sizes to choose from.

Orientation - Specifies how the document is positioned on the page. Portrait orients the paper
vertically while Landscape rotates the paper 90° clockwise.

Custom Layout

Emulate Printer - use this section to emulate the system default printer or another installed printer
driver. PDF Creator Plus will simulate the chosen printer by using its resolution and margins. This will
ensure that the printer driver generates the same line and page breaks as printing to the chosen
printer. When emulating a printer the Resolution and Left/Right and Top/Bottom margin fields are
disabled.

Model - the installed printer driver to emulate. This can be any printer on your computer, or, if <
Default Printer > is chosen then whichever printer has been set as the system default printer will be
used.
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Print Quality

Resolution - specifies the print resolution, or DPI (dots per inch) of the printed pages. Higher
resolutions produce graphic images that are sharper and show finer detail, but are also very large if
they are not compressed. Low-resolution images are not of as high a quality, but they take up less
disk space. If Emulation is enabled, this option reflects the resolution  of the printer being emulated.

Margins

Each printer has left, right, top, and bottom margins that designate the "non-printable" margin area for
that printer. If Emulation is enabled, this option reflects the margins of the printer being emulated.

Left/Right -  left and right width of the non-printable area printer margins.

Top/Bottom -  top and bottom height of the non-printable area printer margins.
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Working with PDF Creator Plus Projects

When PDF Creator Plus is opened from the desktop shortcut or from the Start menu, it initially contains
an  project with 0 pages, or an empty project.

If PDF Creator Plus is opened automatically by printing to the PDF Creator Plus 6.0 printer, the project 
will contain all the pages from the file that was printed to the PDF Creator Plus 6.0 printer.

The following sections are designed to familiarize you with the concept of PDF Creator Plus projects and
how they are used as a holding area (or preview area) for the pages you want to include in your new PDF.
PDF Creator Plus's main feature set is for creating PDF documents but you can also create TIFF, BMP
and JPEG images as well as EMF files.

Once you have collected all of the pages in the preview area, you are ready to create your file. The
collecting of pages can be a simple as printing a single document, or you can combine many different
pages from many different documents.

Working with Projects

Creating Projects

Opening Projects

Adding Pages to a Project

Creating Projects With Outline Information and Hyperlinks 

Saving Projects

Printing PDF Creator Plus Projects

Closing Project Files

Exiting the Application
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Creating Projects

A new project file is an empty file consisting of 0 pages.

1. To create a new project file, go to the File menu and click New Project. You can also click the

New Project  button on the Standard toolbar. This will create a new empty project.
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Opening Projects

Open an existing project

1. To open an existing project file, go to the File menu and click Open Project. You can also click

the Open Project  button on the Standard toolbar.

2. In the Open dialog that appears, browse to the location where the file has been saved. Select the
project file and click the Open button.

a
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Open a recently accessed project

The four most recently accessed project files are listed at the bottom of the File menu between the Print
Setup… and the Exit menu items.
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Adding Pages to a Project

Pages can be added to your PDF Creator Plus projects by printing to the PDF Creator Plus printer from
any Windows application, or by importing the pages from an existing PDF Creator Plus project file.

To add pages from Microsoft® Word documents and to preserve any hyperlinks, styles, and bookmarks
present in the document, use the PEERNET Save As PDF Add-In. The Add-In is documented in the
section Creating Outline Information from Microsoft Word.

Adding Pages to a Project

Adding Pages From a Windows Application

Merging Pages from Different Windows Applications

Adding Pages by Importing

Appending Blank Pages

Adding Pages From a Windows Application

The easiest way to add pages to a project is to print from any Windows application to the PDF Creator
Plus printer that comes with PDF Creator Plus. The PDF Creator Plus printer converts any printed
output created by ANY application to a format that can be inserted into a PDF Creator Plus project.

It’s as easy as 1-2-3.

1. Open ANY document. 

2. Print your document to the PDF Creator Plus printer.
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3. The PDF Creator Plus application will then open and a new project containing the pages of your
document is created by default.
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Merging Pages From Different Windows Applications

You can easily append documents together, such as adding a Microsoft® PowerPoint® presentation or a
Microsoft® Excel spreadsheet to the end of a Microsoft® Word document.

1. Follow the steps in the previous section, Adding Pages From a Windows Application for the first
file you want to be in the PDF file.

2. Then simply leave the PDF Creator Plus application open after printing the first
document, and continue printing each of the documents you want to merge into the
PDF file.

When the PDF Creator Plus application is already running, a dialog prompt is presented to you each time
a new file is added. The dialog box has three options:

append the new pages to the end of the current project

insert these new pages at a particular location

create a new project and discard any current pages.

To add the new pages, choose on of the following:

Append the pages to the end of the project - this will add the pages to the end of all of the pages
in the current project.

Insert the Pages - to insert the pages before or after any of the pages in the current project.

Adding Pages by Importing

Another way to add pages to a project is by importing bitmap (BMP) image files or individual pages pages
from existing PDF Creator Plus projects.
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1. From the File menu, select the Import File… menu item, or click the Import  button on
the Standard toolbar.

2. In the Import File dialog that appears, browse to the PDF Creator Plus project or Windows
Bitmap (BMP) image file you wish to import. Select the file and click the Open button to import
the pages into your current project. You can choose to Append pages to end of the project, or
Insert pages before or after any page in the project. If the project has no pages, the Append
pages to end of the project will be the only option available.
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Inserting Blank Pages

New blank, or empty pages can be added at any point in the project. These pages are perfect for cover
pages, or to separate different sources of information within a project.

1. To insert a new page, go to the Page menu and select Insert Blank menu item.

2. You can insert the page Before or After the current page, or to Append the page to the end
of the project.

3. The thumbnail view context menu also has the Insert Blank menu item with the same options.

4. In the Add New Page dialog that appears, you can choose the Orientation, Page
Resolution, and Page Size of your new page.
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Creating Projects With Outline Information and Hyperlinks

PDF Creator Plus projects can contain outline information and hyperlinks. Outline information is divided
into two categories, Headings and Bookmarks. This information is similar to the table of contents in a
Microsoft® Word document, or the Bookmarks tab in Adobe® Acrobat. Hyperlinks in PDF Creator Plus
are similar to hyperlinks in Microsoft® Word or Adobe® Acrobat.

Creating Projects with Outlines

What are Headings and Bookmarks?

Creating Outline Information from Microsoft® Word

Creating Outline Information Manually

Adding Heading Objects

Adding Bookmark Objects

Adding Hyperlink Information

What are Headings and Bookmarks?

  Productivity Tips - PDF Bookmarks

The outline information, or the headings, in PDF Creator Plus are used to create the
Bookmarks tab in Adobe Acrobat when creating PDF files.

Headings

Headings in PDF Creator Plus are like the headings in Microsoft® Word that make up the Table of
Contents. Like Microsoft Word, PDF Creator Plus headings also have a level specification from one to
nine. All headings in the project are listed under the Headings section of the Outline tab in the Navigation
view. Headings can be set with a magnification option which allows you to set what zoom level of the page
to use when the heading is brought into view.

Bookmarks

A bookmark can be thought of as a named location. It is used to jump to a specific location in the
document by referencing it by name from another location, usually a hyperlink within the document.
Bookmarks are listed under the Bookmarks section of the Outline tab in the Navigation view. Like
headings, bookmarks can also be set with a magnification option which allows you to set what zoom level
of the page to use when the bookmark is brought into view.
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Hyperlinks

Hyperlinks are links to external files, web pages, or to named locations within the document such as a
heading or bookmark. When a PDF file is created from the project, clicking within the area will perform the
hyperlink action. You can make almost every PDF Creator Plus annotation tool into a hyperlink area.

Creating Outline Information

Outline information can be created in two ways:

manually using the Bookmark annotation tool, and hyperlink information created with the
Hyperlink annotation tool.

automatically generated from a Microsoft® Word Document using the PEERNET Save As PDF
6.0 Add-In. PDF Creator Plus projects created using the add-in preserve hyperlinks, styles, and
bookmarks present in the original Word document.

Headings are shown outlined with a red dotted rectangle, bookmarks with a green one and hyperlinks with
blue. These rectangles are only visible on the screen to make it easier to see where the headings,
bookmarks and hyperlinks are; they are not included when the page is printed or used to create a PDF,
TIFF or other type of file.

Creating Outline Information from Microsoft® Word

A Save As PDF 6.0 Add-In is added to Microsoft® Word when the PDF Creator Plus application is
installed. The Save As PDF 6.0 Add-In allows the creation of PDF Creator Plusprojects with outline
information from Microsoft® Word documents that use heading styles, as well as maintaining any
hyperlink information from the document. You can then use this project to create PDF files, TIFF images
or other output types supported by PDF Creator Plus.

  Productivity Tips - PDF Bookmarks

If you do not want to create outline or hyperlink information in your PDF Creator Plus project,
simply print the Word document to the PDF Creator Plus printer through the File – Print
menu item.

1. To convert a Word document to an PDF Creator Plus project with outline and hyperlink
information intact, use the Save As PDF 6.0 Add-In available in Word. Where the Add-In is
accessed from depends on the version of Office you are running.

If you are running Office 2007, 2010 or 2013

Click the Add-Ins tab on the ribbon interface, then select the Save As PDF 5.0.0 button
on the toolbar.
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If you are running Office 2003 or Office XP

Click the Save As PDF 5.0.0 button on the toolbar, or choose File – Save As PDF
5.0.0 from the File menu.

     

2. When you click Save As PDF 5.0.0, the PDF Bookmark Creation Settings dialog will
display. From this dialog you can choose what outline level, from 1 to 9, to assign each available
style in the document. These settings are only used during the Save As PDF 6.0 conversion
process. They do not affect the current styles and formatting in the document. Also, only styles
that have a level assigned to them will be included in the creation of the outline. A preview of each
style that will be included is shown in the Preview section at the bottom of the dialog. Hyperlink
information is always automatically included in the Save As PDF 6.0 conversion process.
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3. When you are satisfied with the settings, click the OK button to start the Save As PDF 6.0
conversion process and launch the progress dialog box.

4. While the progress dialog is displayed, you will see different parts of the document being selected
as the Save As PDF 6.0 Add-In moves through the document and processes each page.
When the process is complete, the document is automatically printed to the PDF Creator Plus
6.0 printer and the PDF Creator Plus application will open with Word document as a new
project.
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5. Document styles that were assigned outline levels are displayed in the Outline view of the
Navigation tab. If you cannot see the Outline view, click on the Outline tab in the Navigation
view to bring the tab forward.

Creating Outline Information Manually

If the pages in your projects are coming from different sources, you may want or need to add additional
outline information manually. Both headings and bookmarks can be added using the Outline tool on the 
Annotation toolbar.

Manual Outline Tools

Adding Heading Objects

Adding Bookmark Objects

Adding Hyperlink Information

Adding Heading Objects

Heading objects are the same as bookmarks in a PDF document. Adding heading items can be thought of
as building your table of contents.

1. Go to the page in the project that you want to be the target of the heading. Select the Outline
annotation tool.
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2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create a rectangle around the area on the page that you want
to represent the heading. Heading objects are normally, but not limited to, a line of text on your
page. Here we are creating a heading object that encompasses the graphic at the top of the page.

3. Release the mouse button when you are done. The outline object creates a heading object by
default. The size and position of the rectangle can be adjusted as required. Headings are shown
outlined with a red dotted rectangle. This rectangle is shown only on the screen to make seeing
the heading annotation easier; it is not included when the page is printed or used to create a PDF,
TIFF or any other type of file.
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4. The new heading annotation has also been added under the Headings section in the Outline
view. If you cannot see the Outline view, click on the Outline tab, the tab with the book icon, in the 
Navigation view to bring the tab forward.

5. You can change the properties of the Heading through the Outline properties dialog,
accessible from the Annotation Properties or the Edit Outline toolbar button.

6. From the Annotation Properties dialog, you can change the text displayed for the heading,
the heading level, its magnification settings and its font options. See Outline Properties for a full
description of this dialog box and its options.
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Adding Bookmark Objects

A bookmark is a named destination that can be jumped to from a hyperlink. This is the same concept as a
book mark in Microsoft® Word but different from a bookmark in Adobe. The steps below will walk you
through how to create a bookmark that can then be jumped to from any hyperlink anywhere in the
document.

1. Go to the page in the project that you want to be the destination of the jump. Select the Outline
annotation tool.

2. The cursor will change from the mouse pointer to a small cross hair (+). Click and hold the left
mouse button while you drag to create a rectangle around the area on the page that you want to
represent the bookmark.
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3. Release the mouse button when you are done. The Outline annotation tool creates a heading
annotation by default. To create a bookmark, the heading annotation properties have to be
changed. You can change the heading annotation to a bookmark annotation through the
Annotation Properties dialog, accessible from the Annotation Properties or the Edit
Outline toolbar button.

4. In the Annotation Properties dialog, change the Heading Level to <None> and type a
name for the bookmark in the Bookmark Name field. This changes the heading annotation to
a bookmark annotation. Click the Apply button to save the changes. See Outline Properties for a
full description of this dialog box and its options.

5. The bookmark outline, as shown above, is now displayed with a green dotted rectangle. This
rectangle is shown only on the screen to make seeing the bookmark area easier; it is not included
when the page is printed or used to create a PDF, TIFF or any other type of file.

6. The new bookmark annotation has also been added under the Bookmarks section in the
Outline view. If you cannot see the Outline view, click on the Outline tab, the tab with the book
icon, in the Navigation view to bring the tab forward.
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Adding Hyperlink Information

The hyperlink annotation allows you to create jump points in the project. A hyperlink can jump to a web
address, a file on disk, or to a location, called a bookmark, inside the project. When a PDF file is created
from this project, these links are maintained inside the PDF document.

1. Go to the page in the project where you want to place a hyperlink. Select the Hyperlink
annotation tool.

2. The cursor will change from the mouse pointer to a small cross hair (+). Click and hold the left
mouse button while you drag to create a rectangle around the area on the page that you want to
represent the hyperlink.

 

3. Release the mouse button when you are done. Hyperlinks are shown outlined with a blue dotted
rectangle. This rectangle is shown only on the screen to make seeing the hyperlink annotation
area easier; it is not included when the page is printed or used to create a PDF, TIFF or any other
type of file.
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4. You can change the properties of the Hyperlink through the Hyperlink properties dialog,
accessible from the Annotation Properties or the Edit Hyperlink toolbar button. See the
section Hyperlink Properties for a full description of this dialog box and its options.

5. To set the hyperlink to link to a web address, choose Link to a website (URL) and enter the
desired web address.

6. To set the hyperlink to link to an external file, choose Link to a file on disk and type in the
filename. The Browse button can be used to quickly navigate to the file on disk. If you are
linking to a PDF file, you can even specify a named bookmark within the PDF file to jump to when
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the document is opened.

7. To set the hyperlink to link to an internal location within the current PDF Creator Plus project,
choose Link to a location in this file. Click the Browse button to launch the Select
Location dialog to choose from the headings and bookmarks available in the project.
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Saving Projects

To save a new project file

1. To save a project file for the first time, go to the File menu and click Save Project. You can also

click the Save Project  button on the Standard toolbar.

2. In the Save As dialog that appears, browse to the location where you want to save the project.
Select a name for your project file and click the Save button.

To save a project file you have modified

To save a project file that you have modified, go to the File menu and click Save Project. You can also

click the Save Project  button on the Standard toolbar.

To save a project file with a different name

1. To save a project file under a different name, go to the File menu and click Save Project As… 



PDF Creator Plus 6.0

55 Working with PDF Creator Plus Projects

Saving Projects

2. In the Save As dialog that appears, browse to the location where you want to save the project.
Select a new name for your project file and click the Save button.
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Printing PDF Creator Plus Projects

PDF Creator Plus offers advanced print and print preview functionality that allows you to see what your
project will look like when printed to the selected printer, before actually printing the document.

Printing PDF Creator Plus Projects

Setting Printer Defaults

Previewing Project Files

Printing Project Files

PDF Creator Plus Printing Options

Setting Printer Defaults

The system default printer is automatically chosen as the selected printer when the application starts. To
change this to another printer, or to change any of the options for that printer, go to the File menu and
click Print Setup.

From the Print Setup dialog that appears, you can change the following:
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use the Name drop list to choose another printer

modify the properties of the chosen printer by clicking on the Properties… button.

change the Paper Size and Orientation of the printed page.

Previewing Projects

Previewing the project allows you to see what the pages will look like before you print them. You can also
change the Page Scaling options through Application Preferences to see how the page would look when
printed using the different page scaling options.

Preview the Project

1. Create a new PDF Creator Plus project or open an existing one.

2. From the File menu, select the Print Preview menu item. You can also click the Print

Preview  button on the Standard toolbar.
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3. The first page of your project is displayed as it would look if it was printed to the printer selected
in Setting Printer Defaults.

Change the Page Scaling

The default printing option for Page Scaling is Fit to Paper. To preview changes to the page scaling
options, change the page scaling defaults through the Printing Defaults tab in the Application
Preferences dialog.

1. From the Edit menu, click the Application Preferences menu item. You can also click the

Preferences  button on the Standard toolbar.

Changes made on this tab will be seen when you preview or print the project. Here the
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page is set to be scaled Actual Size, with Auto-rotate and Center page turned on.

2. The page scaling option set in step 1 above is more readily seen if we also change the Paper
Size to Legal in the Print Setup dialog as shown below.

3. Now in the print preview we see the original page has retained its actual size of Letter paper but
now it is centered on Legal-sized paper.

Printing Projects

1. Create a new PDF Creator Plus project or open an existing one.

2. From the File menu, select the Print menu item. You can also click the Print  button on
the Standard toolbar.
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From the Print dialog that appears, select a printer from the Name drop list.

The Print Range section allows you choose what pages of the project to send to the
printer.

The Page Options section controls the Page Scaling and positioning options. These are
the same options as the Printing Defaults tab in the Application Preferences. Any changes
made in one dialog are reflected in the other dialog. 

o Choose Fit to Printer or Actual Size for the page scaling.

o Enable or disable auto-rotate, center page, or shrink page to position the page as
required.

3. To print your project, click the OK button. A progress dialog will appear as your project is being
printed.

PDF Creator Plus Printing Options

How your project is printed is determined by the Page Options settings on the Print dialog. The same
options also appear on the Application Preferences – Printing Defaults tab.
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Page Options

The page scaling printing option determines how each page in the project is scaled to the paper when
printed. There are two scaling options:

Fit to Paper Enlarges or reduces the page to fit the size of the currently selected paper.

Actual Size Makes no attempt to scale the page; any part of the page that does not fit in the
printable area of the currently selected printer is cropped.

Page Auto-rotation

The Auto-rotate pages to fit printer page option adjusts the pages orientation to maximize the
amount of page printed. If this option is on, the page will be rotated if rotating the page allows more of the
page to fit in the printable area of the currently selected paper.

Page Centering

The Center Page if smaller than printer page option centers the contents of the page if the
page is smaller than the printable area of the currently selected paper. This will not affect pages that are
larger than the printable area.

Page Shrinking

The Shrink page if larger than the printer page option shrinks the contents of the page to fit if
the page is larger than the printable area of the currently selected paper. This gives the same result as Fit
to Paper for larger pages. This does not affect pages that are smaller than the printable area and  only
applies when the page scaling is set to print Actual Size.
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Closing Projects

To close a project file, go to the File menu and click the Close Project menu item.
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Exiting the Application

To exit the application, go to the File menu and click the Exit menu item.
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Creating PDF, TIFF and Other Files From PDF Creator Plus
Projects

One of the primary uses of PDF Creator Plus is to create searchable Adobe® PDF documents (with or
without security), TIFF image files, JPEG image files, Windows Bitmap image files, or placeable
Enhanced Metafile files from a PDF Creator Plus project.

The three most common file formats are readily available from the Create PDF, Create TIFF and
Create JPEG buttons in the Task window at the top of the PDF Creator Plus application.

To create Windows Bitmap (*.bmp) or placeable Enhanced Metafiles (*.emf) files, select the Create

Other File...  button on the Standard toolbar, or choose File – Create Other File… from the
menu.

Creating PDF and other files

Converting to Searchable Abobe® PDF Format

Converting to TIFF Image Format

Converting to JPEG Image Format

Converting to BMP Image Format

Converting to Enhanced Metafile (EMF) Format



PDF Creator Plus 6.0

65 Creating PDF, TIFF and Other Files From PDF Creator Plus Projects

Creating a Searchable Adobe® PDF File

Creating a Searchable Adobe® PDF File

PDF File Options

Creating an Adobe® PDF File

Embedding Fonts in Adobe® PDF Files

Creating Searchable Adobe® PDF Format with Security

Including Outline Information

Including Hyperlink Information

Setting Initial View and Page Layout

Controlling PDF Size with Downsampling

Compressing Images in the PDF File

Creating an Adobe® PDF File

1. Open the file you want as a PDF and print it to the PDF Creator Plus 6.0 printer. You can also
open an existing PDF Creator Plus project ( .pnp file) you have previously saved.

2. Select the Create PDF button from the task window, or select File - Create PDF… from the
menu.

3. The Create File dialog will appear.
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Creating a Searchable Adobe® PDF File

Browse to the location where you wish to save the PDF document and enter the file name
for your new PDF document.

Make sure the Save as type is set to PDF file (*.pdf). 

The Page Range options allow you to select a subset of pages that would be converted
to the PDF document.

Check the Create Multi-page File to make a PDF document that contains all the
pages in one (1) file.

The font embedding, security, outline, hyperlink, initial view and page layout options are
explained in more detail below.

4. Press the Save button to create your PDF document. A progress dialog will appear as your
document is being created.When the document is created, the progress dialog will close. The
new PDF document can now be opened in Adobe® Reader.
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Embedding Fonts in Adobe® PDF Files

Checking the Embed Fonts option will create a PDF file that contains all the font information needed to
allow your file to display correctly on all target machines. This is especially important if you are using Asian
fonts, which may not be installed on all machines. When the fonts are not embedded, Adobe® matches
the fonts as close as it can. PDF files created without embedded fonts are smaller in size than those
created with embedded fonts.

Creating Searchable Adobe® PDF Format with Security

Checking Use Security will add PDF security to your document as shown below.

Now when you press the Save button, you will be prompted as shown below to select the level of PDF
security you desire. See Setting PDF options preferences for more detailed information about the PDF
security options.

If you have enabled any password protection on your PDF document, you will be prompted to confirm the
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passwords you are using. You will be prompted once for the open document password, if you are using it,
and once for the change document password, if you are using it.

Including Outline Information

Any outline information in a PDF Creator Plus project is used to create bookmarks in the PDF file. This
option is enabled by default. Normally created using the PEERNET Save as PDF Add-In from within
Microsoft® Word, headings and bookmarks can also be created manually using the Outline annotation
tool. See the section Creating Projects with Outlines for more information.

To include this information in your PDF document, leave the Include Outline option checked. If you do
not wish to have bookmark information in your PDF document, uncheck this option.

Including Hyperlink Information

Any hyperlink information in a PDF Creator Plus project is used to create hyperlinks in the PDF file as
well. This option is enabled by default. Normally created using the PEERNET Save as PDF Add-In
from within Microsoft® Word, all annotation objects available in PDF Creator Plus, with the exception of
the Line object, can also be a Hyperlink.

There are three styles of hyperlinks available:

link to a web address

link to a file

link to an internal bookmark.

See the section Adding hyperlink information for more details.

To include this information in your PDF document, leave the Include Hyperlinks option checked. If
you do not wish to have hyperlink information in your document, uncheck this option.
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Setting Initial View and Page Layout

These options determine the Initial View and the Page Layout of the PDF file when opened in
Adobe.

Initial View
The Initial View determined which panes and tabs are visible when the PDF document is viewed. There
are three options available for the initial view.

Initial View Description

Page Only Hides the navigation panel and its tabs and shows only the page
in the document pane.

Bookmarks Panel and Page Shows the navigation panel set to the Bookmarks tab and the
page in the document pane.

Pages Panel and Page Shows the navigation panel set to the Pages tab and the page
in the document pane.

 Page Layout
The Page Layout determines the view of the pages in the document pane. There are five options available
for the page layout:

Page Layout Description

Default Uses the individual user’s preferences for page view.

Single Page Shows a single page at a time.

Continuous Page Shows all the pages in a single column

Facing Facing shows the pages in two columns, two pages at a time,
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starting with the first page in the right-most column.

Continuous Facing Shows all the pages in two columns. The first pages starts in
the right-most column

Controlling PDF Size with Downsampling

If there are a lot if images and high quality graphics (such as pictures, screenshots, company logos) in
your PDF file, it can often become quite large. Downsampling is a common technique used to reduce the
amount of information needed to store each image. This can reduce the the overall size of the PDF.

All images are stored at a certain resolution, or dots-per-inch. The higher the resolution, the more space it
takes to store the image. By reducing the resolution of the stored images, or downsampling the image, we
can also reduce the size of the PDF. The side effect of reducing the resolution, especially from a very high
resolution to a very small resolution, can be a loss in quality in the images. Often you will have to balance
image quality with file size to find a happy medium between the two.

Downsampling options are controlled through the Downsampling tab on the Applications
Preferences dialog. Open this dialog by clicking Edit – Application Preferences in the

application menu or the Applications Preferences ( ) toolbar button. Any downsampling options
set on this tab are used when a PDF file is created. An image will only be downsampled if its DPI is higher
then the downsampling DPI chosen for that image color. If the DPI of the image is less than the
downsampling DPI the image is not changed.

As an example, with the settings below, a color image at 300 DPI will be reduced to 150 DPI but a
monochrome image at 200 DPI will not be downsampled as 200 DPI is already less than the chosen
monochrome downsampling level of 300 DPI.

Compressing Images in the PDF File

Another way to control the overall size of your PDF file is by compressing the images (such as pictures,
screenshots, company logos) in your file. Unlike downsampling, image compression, with the exception of
JPG compressed images, will not affect the quality of the images. See Compression Preferences for more
information.
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Compression options are controlled through the Compression tab on the Applications
Preferences dialog. Open this dialog by clicking Edit – Application Preferences in the

application menu or the Applications Preferences ( ) toolbar button. Any compression options set
on this tab are used when a PDF file is created.
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Creating a TIFF Image

Creating a TIFF Image

1. Open the file you want as a TIFF image and print it to the PDF Creator Plus 6.0 printer. You can
also open an existing PDF Creator Plus project ( .pnp file) you have previously saved.

2. Select the Create TIFF button from the task window, or select File - Create TIFF… from the
menu.

3. The Create File dialog will appear.

Browse to the location where you wish to save the TIFF image file and enter the file name
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for your new TIFF image.

Make sure the Save as type is set to TIFF image (*.tif).

The Page Range options allow you to select a subset of pages that would be converted
to the TIFF file.

Check the Create Multi-page File option to make a TIFF image file that contains all
the pages in one (1) file, or uncheck this option to create serialized TIFF images where
each page is a separate image file.

The Use Security, Embed Fonts, Include Outline and Include Hyperlink
options are disabled (grayed out), as they are not applicable to TIFF files.

The Color Mode and Resolution options are explained in more detail below

4. Press the Save button to create your TIFF file. A progress dialog will appear as your file is being
created. The progress dialog will close when the TIFF image file document is created. The new
TIFF image can now be opened in your favorite image viewer.

Changing the TIFF Color Options

There are four color options for creating TIFF files. They can be changed using the Color Mode drop list
in the Output Options section of the Create File dialog.

Color Options Description

Full Color Produces true color output using a palette of up to 16 million colors.

Optimized Automatically reduces each page in your document to the fewest number
of colors possible without affecting output quality. Depending on the
number of colors in the page, the individual pages will be saved as black
and white, 256 colors, or true color.

Grayscale Creates images using a palette of 256 different shades of gray.

Monochrome Creates black and white images.
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Changing the TIFF Image Resolution

The resolution of the TIFF file can be changed using the Resolution drop list. The resolutions available
to be chosen range from 60 DPI (dots per inch) to 2540 DPI. A higher resolution will produce a better
quality image, but also a larger file.

 

Changing the TIFF Image Compression

Another way to control the overall size of your TIFF image file is by changing the compression method
used to compress the data in the image. Different compression options can be used for color, greyscale,
indexed and monochrome images. Not all compression methods are applicable to all color modes; see 
Compression Preferences for more information.

Compression options are controlled through the Compression tab on the Applications
Preferences dialog. Open this dialog by clicking Edit – Application Preferences in the

application menu or the Applications Preferences ( ) toolbar button. Any compression options set
on this tab are used when a TIFF file is created.
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Creating a JPEG Image

Creating a JPEG Image

JPEG files are a serialized file format. A separate JPEG file will be created for each page in the project.
The individual file names will be appended with a number corresponding to the project page number.
Choosing JPEG output for a two-page project file as MyJPG will create two files, MyJPG_0001.jpg and
MyJPG_0002.jpg

1. Open the file you want as a JPEG image and print it to the PDF Creator Plus 6.0 printer. You can
also open an existing PDF Creator Plus project ( .pnp file) you have previously saved.

2. The Create dialog will appear.
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Browse to the location where you wish to save the JPEG image files and enter the file
name for your new JPEG files.

Make sure the Save as type is set to JPEG image (*.jpg). 

The Page Range options allow you to select a subset of pages that would be converted
to JPG image files.

The Create Multi-page File, Embed Fonts, Use Security, Include Outline
and Include Hyperlink options are all disabled (grayed out), as they are not applicable
to JPEG files.

The Color Mode and Resolution options are explained in more detail below.

4. Press the Save button to create your JPEG files. A progress dialog will appear as the files are
being created. The progress dialog will close when all the files are created. The new files can now
be opened in your favorite image viewer.



78

PDF Creator Plus 6.0

Creating PDF, TIFF and Other Files From PDF Creator Plus Projects

Creating a JPEG Image

Changing the JPEG Colour Options

There are three color options for creating JPEG files. They can be changed from the Color Mode drop
list in the Output Options section of the Create File dialog.

Color Options Description

Full Color Produces true color output using a palette of up to 16 million colors.

Optimized Automatically reduces each page in your document to the fewest number
of colors possible without affecting output quality. Depending on the
number of colors in the page, the individual pages will be saved as black
and white, 256 colors, or true color.

Grayscale Creates images using a palette of 256 different shades of gray.

Changing the JPEG Image Resolution

The resolution of the JPEG file can be changed using the Resolution drop list. The resolutions available
to be chosen range from 60 DPI (dots per inch) to 2540 DPI. A higher resolution will produce a better
quality image, but also a larger file.
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Changing the JPEG Image Compression

A JPEG image can only be compressed using JPEG compression, which is a lossy compression
algorithm. Designed for use on photographs, it works best on images with lots of colors as the algorithm
removes unneeded colors from the image. JPEG compression uses an image quality factor to determine
how much to compress the file. A higher image quality will create a better looking image but a larger file.
Reducing the image quality can degrade the image but also creates a smaller file.

 . It is the JPEG compression image quality setting that determines what level of compression to use.
JPEG compression is a lossy compression method, meaning the more compressed the image the lower
in quality the image The compression  be used for color, greyscale, indexed and monochrome images.
Not all compression methods are applicable to all color modes; see Compression Preferences for more
information.

Compression options are controlled through the Compression tab on the Applications
Preferences dialog. Open this dialog by clicking Edit – Application Preferences in the

application menu or the Applications Preferences ( ) toolbar button.

The JPEG Image Quality slider control at the bottom of the tab controls the image quality factor. Any
JPEGs created, or any TIFF images creates using JPEG compression,  will use this setting.
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Creating a BMP Image

Creating a BMP Image

BMP files are a serialized file format. A separate BMP file will be created for each page in the project.
The individual file names will be appended with a number corresponding to the project page number.
Choosing BMP output for a two-page project file as MyBMP will create two files, MyBMP_0001.bmp and
MyBMP_0002.bmp.

1. Open the file you want as a BMP image and print it to the PDF Creator Plus 6.0 printer. You can
also open an existing PDF Creator Plus project ( .pnp file) you have previously saved.

2. Select File – Create Other File … from the menu. You can also click the Create Other

File  button on the Standard toolbar.

3. The Create File dialog will appear. By default, this dialog is set to create the type of file last
created. The default is PDF upon installation. Use the Save as type combo box to choose
Bitmap Image (*.bmp).
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Browse to the location where you wish to save the BMP image files and enter the file name
for your new BMP files.

Make sure the Save as type is set to BMP image (*.bmp).

The Page Range options allow you to select a subset of pages that would be converted
to BMP image files.

The Create Multi-page File, Embed Fonts, Use Security, Include Outline,
and Include Hyperlinks options are all disabled (grayed out), as they are not
applicable to BMP files.

The Color Mode and Resolution options are explained in more detail below.

4. Press the Save button to create your BMP files. A progress dialog will appear as the files are
being created. The progress dialog will close when all the files are created. The new files can now
be opened in your favorite image viewer.
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Changing the BMP Color Options

There are four color options for creating BMP files. They can be changed from the Color Mode drop list
in the Output Options section of the Create File dialog.

Color Options Description

Full Color Produces true color output using a palette of up to 16 million colors.

Optimized Automatically reduces each page in your document to the fewest number
of colors possible without affecting output quality. Depending on the
number of colors in the page, the individual pages will be saved as black
and white, 256 colors, or true color.

Grayscale Creates images using a palette of 256 different shades of gray.

Monochrome Creates black and white images.

Changing the BMP Image Resolution

The resolution of the BMP file can be changed using the Resolution drop list. The resolutions available
to be chosen range from 60 DPI (dots per inch) to 2450 DPI. A higher resolution will produce a better
quality image, but also a larger file.
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Changing the BMP Image Compression

Another way to control the overall size of your BMP image file is by changing the compression method
used to compress the data in the image. Different compression options can be used for color, greyscale,
indexed and monochrome images. Not all compression methods are applicable to all color modes; see 
Compression Preferences for more information.

Compression options are controlled through the Compression tab on the Applications
Preferences dialog. Open this dialog by clicking Edit – Application Preferences in the

application menu or the Applications Preferences ( ) toolbar button. Any compression options set
on this tab are used when a BMP file is created.
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Creating a Placeable Enhanced Metafile (EMF)

Creating an Enhanced Metafile (EMF) File

EMF files consist of a sequence of Windows® graphics functions and are intended to be portable between
Windows® applications. They are contain vector and bitmap components and are generally are used to
store line-art, illustrations and content created in drawing or presentation applications.

EMF files are a serialized file format. A separate EMF file will be created for each page in the project.
The individual file names will be appended with a number corresponding to the project page number.
Choosing EMF output from a two-page project file as MyEMF will create two files, MyEMF_0001.emf and
MyEMF_0002.emf.

1. Open the file you want as an EMF file and print it to the PDF Creator Plus 6.0 printer. You can
also open an existing PDF Creator Plus project ( .pnp file) you have previously saved.

2. Select File – Create Other File … from the menu. You can also click the Create Other

File  button on the Standard toolbar.

3. The Create File dialog will appear. By default, this dialog is set to create the type of file last
created. The default is PDF upon installation. Use the Save as type combo box to choose
Enhanced metafile (*.emf).
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Browse to the location where you wish to save the EMF files and enter the file name for
your new EMF files.

Make sure the Save as type is set to Enhanced metafile (*.emf).

The Page Range options allow you to select a subset of pages that would be converted
to EMF image files.

All other options are disabled (grayed out), as they are not applicable to EMF files.

4. Press the Save button to create your EMF files. A progress dialog will appear as the files are
being created. The progress dialog will close when all the files are created. The new files can now
be opened in your favorite image viewer
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Inserting an EMF file into Word Document

EMF files are designed to be portable between applications and a common use for these files is to be
inserted into other documents.

1. To insert a placeable Enhanced Metafile into a Word document, select Insert - Picture -
From File... from the menu.

2. From the Insert Picture dialog that appears, browse to the location that contains the EMF file
you want to insert. Select the EMF file and click the Insert button.

3. The metafile is added to the document. When you click on the image in the Word document, a
black border will appear. With this border, you can move or resize the metafile. Right-clicking on
the image will give you a context menu with common actions for inserted pictures.
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Working with Pages

You can quickly and easily move from page to page, and customize the order and appearance of your
pages using the Thumbnail View on the left hand side of the Design window. The Thumbnail view shows
the current list of pages in the project as small thumbnail pictures. Under each thumbnail picture is the
page number of the page within the project.

Right-clicking any thumbnail picture brings up a context-sensitive menu that provides page specific
operations such as Rotate, Move or Copy Pages. These same operations are also available from the
applications menu bar under the Page menu.

Working with Pages

Navigating Between Pages

Moving Pages

Copying Pages

Inserting Pages

Deleting Pages

Rotating Pages

Viewing Page Properties
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Navigating Between Pages

You can navigate through your pages using the thumbnail view in the left pane of the application. The
currently selected page is shown with a double rectangle around it.

To move the selection to another page left click on the desired page in the thumbnail view, or use the
keyboard arrow keys to move the selection rectangle to another page.

You can also use the View toolbar's current page control to move the selected page by clicking the left
arrow to go back one page and the right arrow to go forward one page.

The Page menu commands, Next, Previous, First, and Last also allow you to navigate through the
pages.
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Moving Pages

You can move, or reorder, the pages in your PDF Creator Plus project using the pages in the thumbnail

view. When you are moving a page, the mouse cursor will change to a pointed cross hair cursor ( ) and
a straight line will appear between the pages to show you where the page will be inserted.

Moving a Single Page

1. Left-click the page you wish to move and without releasing the left mouse button, drag the page to
its new location.
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Moving a Range of Pages

1. To move a range of pages, go to the Page menu and select Move Range… or right-click on a
page in the thumbnail view and choose Move Pages from the context menu.

2. In the Move Pages dialog that appears, enter in the page range to move, and select the
position to move them to in the project.
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Copying Pages

You can copy the pages in your PDF Creator Plus project using the pages in the thumbnail view. When

you are copying a page, the mouse cursor will change to a pointed cross hair cursor ( ) with a small
plus symbol to designate that this is a copy and not a move. A straight line will appear between the pages
to show you where the new pages will be inserted.

Copy pages using the thumbnail view

Copying pages is done the same manner as moving pages, except that you also hold down the CTRL key
before clicking and dragging the page you want to copy.

1. Press and hold the CTRL key on the keyboard and left-click the page you wish to move.

2. Without releasing the left mouse button or the CTRL key, drag the page to its new location.
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Copying a range of pages

1. To copy a range of page, go to the Page menu and select Copy, and then Range… 

2. In the Copy Pages dialog that appears, enter in the page range to copy, and select the position
to move the new pages to in the project.

Copying pages to the clipboard

The pages can be copied to the clipboard to later paste into another location in the PDF Creator Plus
project, or to paste them into another PDF Creator Plus project.

1. Select the desired page in the thumbnail view

2. Go to the application's Page menu, select the Copy menu item, then select the Page menu
item.



94

PDF Creator Plus 6.0

Working with Pages

Copying Pages

You can also right click on the page in the thumbnail view and select Copy Page from the context menu.
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Inserting Pages

New blank pages can be inserted into the project at any point, and any existing pages copied to the
clipboard can be pasted into the project. See Adding pages from Windows applications and Merging
Pages From Different Windows Applications to see how to insert pages from other file formats.

Inserting pages from the clipboard

Pages that have been copied to the clipboard can be pasted into the project using the context menu in the
thumbnail view. 

1. Right-click on the page thumbnail and choose Page Page - Before, Paste Page - After or Paste
Page Append to to paste the page before or after the currently selected page, or to append the
page to the end of the project. Right-clicking the background of the thumbnail view will only allow
you to Append the page to the end of the project.

You can also paste pages from the clipboard using the Page menu

1. Go to the Page menu, select Paste and then select to paste the page Before or After the
current page, or to Append the page to the end of the project.

Inserting new pages

New blank, or empty pages can be added at any point in the project. These pages are perfect for cover
pages, or to separate different sources of information within a project.

1. To insert a new page, go to the Page menu and select Insert Blank menu item.

2. You can insert the page Before or After the current page, or to Append the page to the end
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of the project.

3. The thumbnail view context menu also has the Insert Blank menu item with the same options.

4. In the Add New Page dialog that appears, you can choose the Orientation, Page
Resolution, and Page Size of your new page.



PDF Creator Plus 6.0

97 Working with Pages

Deleting Pages

Deleting Pages

Pages in the project can be marked for deletion. The pages are not actually deleted until the project is
saved to disk. This allows the pages to be unmarked, or undeleted, if you mark the wrong page or change
your mind. Pages marked for deletion have a red X through them in the thumbnail view.

Mark a page deleted using the thumbnail view

1. Left-click on the page to be deleted in the thumbnail view.

2. Right-click the page to bring up the context menu and select the Delete menu item, then select
Page from the submenu. You can also mark a single page for deletion by left-clicking on the
page in the thumbnail view and using the Delete key on the keyboard.
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Mark a page deleted using the menu

1. Left-click on the page to be deleted in the thumbnail view.

2. Go to the application's Page menu , select the Delete menu item, then select Page from the
submenu.

Mark a range of pages deleted

1. Go to the Page menu and select Delete, and then Range… 

2. In the Mark Pages Deleted dialog that appears, enter in the page range to delete and click
the OK button.

You can also right-click on any undeleted page in the thumbnail view and select Delete and then
Range… from the context menu.

Cut a page using the clipboard

Cutting a page to the clipboard copies the page to clipboard and marks that page to be deleted.

1. Left-click the desired page in the thumbnail view to select it.

2. From the the application's Page menu select the Cut menu item.
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You can also right-click on the page in the thumbnail view and select Cut Page from the context menu.

Remove deletion mark using the thumbnail view

1. Left-click on the page in the thumbnail view to select it.

2. Right-click the page to bring up the context menu, select the Undelete menu item, then select
Page from the submenu.

You can also mark a single page for deletion by clicking on the thumbnail view and using the Delete key
on the keyboard.
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Remove deletion mark using the menu

1. Left-click the page in the thumbnail view to select it.

2. Go to the application's Page menu, select the Undelete menu item, then select Page from the
submenu.

Remove deletion mark from a range of pages

1. Go to the applications's Page menu and select Undelete, then Range…

2. In the Mark Pages Undeleted dialog that appears, enter in the page range to remove the
deletion mark from and click the OK button.

You can also right click on any deleted page in the thumbnail view, select Undelete, and then Range…
from the context menu.
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Rotating Pages

Pages in the project can be rotated 180° or left or right 90°. These operations are available from the 
Page menu from the Rotate and Rotate All menu items,

They are also available from the View toolbar.

Rotating a single page

1. Left-click on the page to be rotated in the thumbnail view to select it.

2. Right-click the page to bring up the context menu, select the Rotate Page menu item, then
choose Left, Right or 180 from the submenu. Left or Right rotates the page 90° in that
direction, 180 will rotate the page a full 180°.

Rotating all pages

1. To rotate all the pages in the project, right-click anywhere in the thumbnail view to bring up the
context menu.

2. Select the Rotate All Pages menu item, then select Left, Right or 180 from the submenu.
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Left or Right rotates the page 90° in that direction, 180 will rotate the page a full 180°.
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Viewing Page Properties

Viewing the properties of the page will show the page dimensions and resolution of the selected page.
These properties depend on the PDF Creator Plus printer settings at the time when the page was printed
or the options chosen on the Add New Page dialog box if the page was added manually.

From the Page menu, click the Properties… menu item, or click the Properties  button on the
Standard toolbar.

Page Settings

Shows the paper size, page orientation and resolution of the page.

Page Size

Displays the actual physical page size of the page. The size can be displayed at Inches, Millimeters,
Centimeters and Pixels.
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Annotating Pages

You can add annotations to any page. Available annotation tools include text, filled and hollow rectangles,
lines, and shapes, among others. They are accessible from both the application menu and the annotation
toolbar. You can also edit individual annotation properties and set default properties for the annotation
tools themselves.

Annotating Pages

Adding Annotations

Selecting Annotations

Copying Annotations

Deleting Annotations

Editing Annotation Properties

Arranging Annotations
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Adding Annotations

Annotations consist of text notes, filled and hollow shapes such as rectangles, circles and polygons, an
eraser and a selection mode for copying parts of the page. Also available are special heading, bookmark
and hyperlink annotations specific to PDF creation.

Annotating Pages

Adding a Text Box

Adding a Heading

Adding a Bookmark

Adding a Hyperlink

Adding a Rectangle

Adding an Ellipse

Adding a Line

Adding a Polygon

Adding a Closed Curve

Erasing a Selected Area

Copying and Pasting Images

Editing Annotation Vertices

Sticky Annotations

Sticky Annotations mode is useful when adding
multiple annotations of the same type to a page.
When Sticky Annotations turned on, the selected
annotation tool remains chosen until you click the

Select  tool again, allowing you to place multiple
annotations on the the page. When this mode is off,
the Select tool becomes active after you place a
single instance of the chosen annotation on the
page.

You can change the sticky mode through the
Annotation menu by checking or un-checking the
Sticky Annotations menu item. By default Sticky
Annotations is turned off.

Undo and Redo on Annotations

Each page maintains its own undo/redo list for annotations. This allows you to easily back out changes, or
redo changes again. Almost any action on an annotation, such as move, size, align, add, delete, even
changing the font of text annotation, are all tracked in the undo/redo list.
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You can undo any annotation operation by clicking the Undo button on the Standard toolbar or through
the Undo menu item on the Edit menu

You can redo any annotation operation by clicking the Redo button on the Standard toolbar or through
the Redo menu item on the Edit menu.

Adding a Text Box

1. Select the Text annotation tool  from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create a rectangle outline on the page. Release the mouse
button when the rectangle is the size you want the text box annotation to be.

3. When the mouse button is released, the text box will automatically go into edit mode to allow you
to type your text. Click outside the text box to accept the typed text and stop editing.



PDF Creator Plus 6.0

107 Annotating Pages

Adding Annotations

4. A text box defaults to transparent fill with no border and used 10 point Arial font for the text. With
the text box annotation selected, press the Enter key or select the elect the Annotation

Properties ( ) toolbar button to edit the properties of the text box.

5. The Annotation Properties dialog will appear showing the properties that are available to be
edited for the text box. If you change a property, the Apply button in the lower right corner will
become enabled. By clicking this button, the changes you have made will be temporarily applied
to the annotation on the page. To keep the changes, click OK. Clicking Cancel will abandon the
changes and return the annotation back to its original state.

  Productivity Tips - Adding a text box from the clipboard

You can create a Text box annotation from text that you have placed in the clipboard from
another application. Right-click on the page and and select Paste from the context menu.

Adding a Heading

1. Select the Outline tool  from the Annotations toolbar.
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2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create a rectangle outline around the area on the page where
you want the heading to be. Release the mouse button when you are done.

3. The heading will be shown outlined with a red dotted rectangle. This rectangle is shown only on
the screen to make seeing the heading annotation easier; it is not included when the page is
printed or used to create a PDF, TIFF or other type of file.

4. The heading annotation defaults to Heading Level 1 and Heading Text as Heading Text.

With the annotation selected, press the Enter key or select the Annotation Properties (
) toolbar button to edit its properties.

5. The Annotation Properties dialog will appear showing the properties that are available to be
edited for the heading. If you change a property, the Apply button in the lower right corner will
become enabled. By clicking this button, the changes you have made will be temporarily applied
to the annotation on the page. To keep the changes, click OK. Clicking Cancel will abandon the
changes and return the annotation back to its original state.

6. If the Outline tab is active in the Navigation view, you will see the newly created heading added
to the outline tree.

Adding a Bookmark

1. Select the Outline tool  from the Annotations toolbar.
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2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create a rectangle outline around the area on the page where
you want the bookmark to be. Release the mouse button when you are done.

3. By default, the Outline tool creates a heading annotation. You can change the heading
annotation to a bookmark annotation through the Annotation Properties dialog, accessible

from the Annotation Properties ( ), the Edit Outline ( ) toolbar button, or by
pressing the Enter key with the bookmark annotation selected.

4. The Annotation Properties dialog will appear showing the properties that are available to be
edited for the bookmark. Change the Heading Level to <None> and enter in a name for your
bookmark in the Bookmark Name field. If you change a property, the Apply button in the
lower right corner will become enabled. By clicking this button, the changes you have made will be
temporarily applied to the annotation on the page. To keep the changes, click OK. Clicking
Cancel will abandon the changes and return the annotation back to its original state.

5. The bookmark will be shown outlined with a green dotted rectangle. This rectangle is shown only
on the screen to make seeing the bookmark annotation easier; it is not included when the page is
printed or used to create a PDF, TIFF or other type of file.

6. If the Outline tab is active in the Navigation view, you will see the newly created bookmark
added to the outline tree.
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Adding a Hyperlink

1. Select the Hyperlink tool ( ) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small cross hair cursort (+). Click and hold
the left mouse button while you drag to create a rectangle outline around the area on the page
where you want the hyperlink to be. Release the mouse button when you are done.

3. The hyperlink will be shown outlined with a blue dotted rectangle. This rectangle is shown only on
the screen to make seeing the hyperlink annotation easier; it is not included when the page is
printed or used to create a PDF, TIFF or other type of file.

4. A hyperlink annotation does not contain a link to a file, website or bookmark location by default.

With the annotation selected, press the Enter key or select the Annotation Properties (
) toolbar button to edit the properties of the hyperlink.

5. The Annotation Properties dialog will appear showing the properties that are available to be
edited for the hyperlink. If you change a property, the Apply button in the lower right corner will
become enabled. By clicking this button, the changes you have made will be temporarily applied
to the annotation on the page. To keep the changes, click OK. Clicking Cancel will abandon the
changes and return the annotation back to its original state.

Adding a Rectangle

Adding a Filled Rectangle

1. Select the Filled Rectangle tool ( ) from the Annotations toolbar.
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2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create a rectangle outline on the page. Release the mouse
button when the rectangle is the size you want.

3. The rectangle fill color defaults to black. With the annotation selected, press the Enter key or

select the elect the Annotation Properties ( ) toolbar button to edit the properties of the
annotation.

4. The Annotation Properties dialog will appear showing the properties that are available to be
edited for the filled rectangle tool. If you change a property, the Apply button in the lower right
corner will become enabled. By clicking this button, the changes you have made will be
temporarily applied to the annotation on the page. To keep the changes, click OK. Clicking
Cancel will abandon the changes and return the annotation back to its original state.

Adding a hollow rectangle

1. Select the Hollow Rectangle tool ( ) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create a rectangle outline on the page. Release the mouse
button when the rectangle is the size you want.
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3. The hollow rectangle defaults to transparent with a black border. With the annotation selected,

press the Enter key or select the elect the Annotation Properties ( ) toolbar button to
edit the properties of the annotation.

4. The Annotation Properties dialog will appear showing the properties that are available to be
edited for the hollow rectangle tool. If you change a property, the Apply button in the lower right
corner will become enabled. By clicking this button, the changes you have made will be
temporarily applied to the annotation on the page. To keep the changes, click OK. Clicking
Cancel will abandon the changes and return the annotation back to its original state.

  Productivity Tips - Adding a Filled or Hollow Square

To draw a square, use the Filled Rectangle or Hollow Rectangle tool and hold down
the Shift key on the keyboard while you drag the mouse.

Adding an Ellipse

1. Select the Ellipse tool ( ) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create an ellipse outline on the page. Release the mouse
button when the ellipse is the size you want.
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3. The ellipse defaults to transparent fill with a black border. With the annotation selected, press the 

Enter key or select the Annotation Properties ( ) toolbar button to edit the properties of
the annotation.

4. The Annotation Properties dialog will appear showing the properties that are available to be
edited for the ellipse. If you change a property, the Apply button in the lower right corner will
become enabled. By clicking this button, the changes you have made will be temporarily applied
to the annotation on the page. To keep the changes, click OK. Clicking Cancel will abandon the
changes and return the annotation back to its original state.

  Productivity Tips - Adding a Circle

To draw a circle, use the Ellipse tool and hold down the Shift key on the keyboard while you
drag the mouse.

Adding a Line

1. Select the Line tool ( ) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
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left mouse button while you drag to create a line on the page. Release the mouse button when the
line is the length you want.

3. A line defaults to a black solid line with a width of one pixel. With the line selected, press the 

Enter key or select the Annotation Properties ( ) toolbar button to edit the properties of
the line.

4. The Annotation Properties dialog will appear showing the properties that are available to be
edited for a line. If you change a property, the Apply button in the lower right corner will become
enabled. By clicking this button, the changes you have made will be temporarily applied to the
annotation on the page. To keep the changes, click OK. Clicking Cancel will abandon the
changes and return the annotation back to its original state.

  Productivity Tips - Creating a Straight Line

To draw a horizontal or vertical straight line the Line tool hold down the Shift key on the
keyboard while you drag the mouse left to right or up and down.

Adding a Polygon

1. Select the Polygon tool ( ) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create the first line segment of the polygon. Release the left
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mouse button when the first line segment is the length you want.

3. Move to the next location and left-click once to add a new line segment. Repeat this until you have
your desired polygon shape. Double-click the left mouse button to finish the  polygon.

4. A polygon defaults to a transparent fill with a solid black border. With the polygon selected, press

the Enter key or select the Annotation Properties ( ) toolbar button to edit the properties
of the polygon.

5. The Annotation Properties dialog will appear showing the properties that are available to be
edited for a polygon. If you change a property, the Apply button in the lower right corner will
become enabled. By clicking this button, the changes you have made will be temporarily applied
to the annotation on the page. To keep the changes, click OK. Clicking Cancel will abandon the
changes and return the annotation back to its original state.

  Productivity Tips - Creating Straight Lines in a Polygon

To draw a horizontal or vertical straight line with the Polygon tool hold down the Shift key
on the keyboard while you drag and click the mouse.
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Adding a Closed Curve

1. Select the Closed Curve tool ( ) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create the first line segment of the closed curve area. Release
the left mouse button when the first line segment is the length you want.

3. Move to the next location and left click once to create a new line segment. Continue this until you
have your desired closed curve shape. When you have three segments or more, you will see a
dotted line that represents what the curve will look like. Double-click the left mouse button to finish
the closed curve shape.

4. A closed curve to a transparent fill with a solid black border. With the closed curve selected, press

the Enter key or select the Annotation Properties ( ) toolbar button to edit its properties.

5. The Annotation Properties dialog will appear showing the properties that are available to be
edited for a closed curve. If you change a property, the Apply button in the lower right corner will
become enabled. By clicking this button, the changes you have made will be temporarily applied
to the annotation on the page. To keep the changes, click OK. Clicking Cancel will abandon the
changes and return the annotation back to its original state.

Erasing a Selected Area

1. Select the Eraser tool ( ) from the Annotations toolbar. An erased area is simply a while filled
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rectangle with no border that covers the text and images underneath.

2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create a rectangle outline around the area on the page you
want to erase. Release the left mouse button when the rectangle is the size you want.

Copying and Pasting Images

Copy an Area as An Image

1. Select the Select Image tool ( ) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small cross hair cursor (+). Click and hold the
left mouse button while you drag to create a rectangle outline around the area on the page you
want to copy. Release the mouse button when the rectangle is the size you want.

3. The copied area is placed on the page in the exact same position as the original area. Left-click
with the mouse to select the copied image and drag the new image to the desired location.

Paste an Image From the Clipboard

You can create a Image annotation from an image that you have copied into the clipboard from another
application.
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1. Right click the page to get the context menu and select Paste from the menu.

2. A new image annotation will be created from the clipboard contents.

Editing Annotation Vertices

1. Select the annotation whose vertices you want to change, then select the Edit Vertices tool (

) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to a small square with arrows ( ) when you
mouse over a vertex on the selected annotation.

3. Click and hold the left mouse button while you drag to move the vertex to a new location.

4. Release the mouse button when you are done.
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Panning to Reveal Hidden Areas

If you are viewing your page at a large zoom, or magnification level, only a portion of your entire page may
fit inside the window, and scroll bars are included to allow navigation around the page. To change the part

of your page that can be see, the Pan tool ( ) is used to move the page displayed in the window.

1. Select the Pan tool ( ) from the Annotations toolbar.

2. The cursor will change from the mouse pointer to an open hand  when you mouse over the
page. 

3. Click and hold the left mouse button while you drag to move page in the desired direction. While
you are panning, the cursor will change to a grabbing hand .

4. Release the left mouse button to stop panning the page.

Selecting an Annotation

To edit, move or delete an annotation, it first has to be selected. 

1. Select the Select ( ) tool from the Annotations toolbar.

2. When in selection mode, the cursor will be the normal mouse pointer 

3. Mouse over and click the annotation you want to select. The annotation will be shown with gray
handles on its perimeter.

Selecting a Group of Annotations

1. To select a group of annotations, select the Select ( ) tool from the Annotations toolbar.

2. When in selection mode, the cursor will be the normal mouse pointer .

3. Mouse over and click the first annotation you want to select. The annotation will be shown with
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gray handles on its perimeter.

4. To select additional annotations, press and hold the CTRL key while you left-click with the mouse
on each of the other annotations you want to select.

5. The last annotation selected is the primary annotation used to determine the size and alignment
standards when using any alignment commands commands. This annotation is identified with
gray handles on its perimeter while the other annotations have white handles.

Selecting Annotations With the Selection Rectangle

You can also select a single annotation or a group of annotations by dragging a selection rectangle
around them.

1. To select a group of annotations, select the Select ( ) tool from the Annotations toolbar.

2. Click and hold the left mouse button while you drag to create a rectangle around all the
annotations you want to select.

3. Release the mouse button the select all annotations inside the dotted rectangle.

Deselect an Annotation From a Group

To remove a single annotation from a selected group, hold down the Shift key and left-click with the
mouse on the annotation you want to deselect.

Changing the Primary Annotation

If you have multiple annotations selected. you can change which annotation is the primary annotation by
holding down the CTRL key and left clicking with the mouse on the annotation you want to designate as
the primary annotation.
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Copying Annotations to the Clipboard

Any annotation or group of annotations can be copied to the clipboard, making it easy to copy annotations
from page to page.

1. Select the annotation(s) you want to copy

2. Click on the Copy ( ) button on the Standard toolbar to copy the annotation to the clipboard,

You can also copy annotation(s) to the clipboard using the context menu.

1. Select the annotation(s) you want to copy.

2. Right- click inside one of the selected annotation(s) to bring up the context menu.

3. From the context menu, select the Copy menu item.
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Pasting annotations from the clipboard

Once an annotation or group of annotations is copied to the clipboard, they can be copied to any page in
the project.

1. Go to the page where you want to paste the annotations.

2. Click the Paste ( ) button on the Standard toolbar.

You can also copy annotation(s) to any page in the project using the context menu.

1. Go to the page where you want to paste the annotations.

2. Right-click on the page to bring up the context menu.

3. From the context menu, select the Paste menu item.
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Deleting Annotations

Deleting a Single Annotation or a Group of Annotations

To delete a single annotation, select that annotation and delete it using the Delete key on the keyboard.
Alternatively, you can delete an annotation through the Delete menu item from the Edit menu.

To delete a group of annotations, select the annotations you want to delete, and follow the same steps as
above.

You can also delete a single annotation or a group of selected annotations using the context menu.
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Cut an annotation or group of annotations to the clipboard

Cutting annotation(s) will copy them to the clipboard and delete them from the page as well.

To cut an annotation to the clipboard, select that annotation then click on the Cut ( ) button on the
Standard toolbar.

You can also cut annotations using the context menu by selecting the annotation and right-clicking inside
one of selected annotation(s) to bring up the context menu. From the context menu, select the Cut menu
item.
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Editing Annotation Properties

You can edit the properties of selected annotations, as well as the default properties of the annotation
tools themselves. Most annotations support editing line, fill and hyperlink properties. Text annotations also
allow you to modify font properties while outline annotations such as headings bookmarks also have
outline properties.

Annotation Properties

Font Properties

Fill Properties

Line Properties

Hyperlink Properties

Outline Properties

Annotation Tool Default Properties

Editing Annotation Properties

Font Properties

Font properties only apply to text annotations.

Font List

The list on the left displays all the fonts on your system. Select a font from this list to apply to the text
in the text annotation.
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Font Styles

You can apply Regular, Bold, Italic and Bold Italic formatting to the text from the middle list. The
formatting options here depend on the font selected.

Font Size

The last list shows all available font sizes for the selected font.

Font Effects

Check or uncheck the Underline or Strike-Out check boxes to apply or remove this effect on your text.

Text Color

Set the color of the text in the annotation.

The text color can be changed by clicking on the down arrow on the right of the 

Color button  to pop up the color control. Select a color by clicking
on one of the color boxes, or click the Other… button to choose a custom color.

Fill Properties

Fill properties apply to the inside area of all annotations except Outline annotations.

Foreground Color

This is the main color of the annotation when No Hatch is selected. If a Hatch pattern is selected,
this color is used to draw the hatches (lines) of the pattern.This color is only used if Transparent
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Fill is turned off.

The fill color can be changed by clicking on the down arrow on the right of the 

Color button  to pop up the color control. Select a color by clicking
on one of the color boxes, or click the Other… button to choose a custom color.

Background Color

This is the alternate color of the annotation when a Hatch pattern other than No Hatch is selected.
This color is used to fill in between the hatches (lines) of the pattern. This color is only used if 
Transparent Background is turned off.

The background color can be changed by clicking on the down arrow on the right

of the Color button  to pop up the color control. Select a color by
clicking on one of the color boxes, or click the Other… button to choose a
custom color.

Transparent Fill

Transparent (or see through) fill applies to the inside area of the annotation. If this is checked on, no
color is used to fill the shape. If this is not checked then the selected foreground and background
colors (as applicable) are used to fill in the shape.

Transparent Background

Transparent (or see through) background applies to all Hatch patterns other than No Hatch. If this is
not checked the Background Color is used to fill in between the hatches (lines) of the pattern.

Hatch

This lists several patterns that can be used to fill in a annotation. The colors of the patterns are taken
from the Foreground Color and Background Color options.
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Line Properties

Line properties apply to the outside area, or border of all annotations except the Outline annotation.

Color

This is the main color of the annotation outline. This color is only used if the Transparent option is
not checked.

The line color can be changed by clicking on the down arrow on the right of the 

Color button  to pop up the color control. Select a color by clicking
on one of the color boxes, or click the Other… button to choose a custom color.

Transparent

If this is checked on, no border is drawn around the annotation. If this is checked off, then the
selected color is used to draw a border of the chosen width.

Style

Set the style of the line, or border, drawn around the annotation. Styles other than Solid only apply to
lines with a Width of zero.

Width

This determines the width of the line, or border, drawn around the annotation. If a width greater than
zero is chosen, only the Solid style of line can be drawn.
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Hyperlink Properties

Hyperlink properties apply to all annotations except Lines, Bookmarks and Headings. The hyperlink
properties determine the behavior of the hyperlink when a PDF is created from the project. Hyperlink
information has no effect when creating TIFF, BMP, JPG or EMF files.

Link to a website (URL)

This is the most common use of a hyperlink. Enter a web address, or URL, to have the user directed
to the specified website. The address can be validated using the Validate button to the right. To link
to a bookmark on a web page, add a #bookmark name to end of the address specification.

Link to a file on disk

Select this option to have the user directed to another file. If you are linking to an Adobe® PDF
document, you can have the file opened at a particular location by supplying the name of a bookmark
within that file. When linking to another PDF document, you also have the option of opening the
document in a new window, or in the existing application window.

Link to a location in this file

Use this option to link to an existing heading or bookmark area in this project. To select a heading or
bookmark, click on the Browse button on the right to display the Select Location dialog allowing
you to choose from the project’s heading and bookmarks.
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The Select Location dialog displays a tree listing all of the current headings and bookmarks in the
project. The current target of the hyperlink, if any, will be highlighted in the tree. Choose the desired
heading or bookmark and click OK to have the hyperlink use the new heading or bookmark.

Outline Properties

Outline properties apply only to outline annotations. Outline annotations can be either headings or
bookmarks. An outline annotation is considered a heading if it has a heading level between one and
nine. Headings are displayed in the Headings section of the Outline tab in the Navigation view.

An outline annotation with a heading level of <None> is a bookmark. Bookmarks are displayed in the
Bookmarks section of the Outline tab in the Navigation view

Heading Level

A heading level between 1 and 9 can be assigned to a heading object. Changing the heading level to 
<None> changes the object from a heading annotation to a bookmark annotation.

Heading Text

The text to be displayed for this heading can be changed here. This is the text that will appear in the
Bookmark panel in Adobe® Acrobat and Adobe® Reader.
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Bookmark Name

This field only applies only to bookmark annotations. It is disabled for heading annotations. To enable
this field, change the heading level to <None> to change the heading annotation into a bookmark
annotation.

Magnification

Set the page magnification of the destination of the header annotation. The option chosen here
applies to Adobe’s Bookmarks tab when a PDF is created from the project. This option determines
how the page is displayed in Adobe when the header is selected in Adobe’s Bookmarks tab.

Magnification Description

Fixed This option enables the Level drop down combo box. The
level chosen from the drop down is used to display the
page.

Fit Page The page is scaled to fit within the window

Fit Width The page is scaled so that the entire width is displayed in
the window.

Inherit Zoom The page is shown at the current magnification level.

Text Color, Italic and Bold

Set the color of the heading text when viewed in Adobe’s Bookmarks tab, as well as in PDF Creator
Plus’ Outline view tab. The text can also be changed to italic or bold font.

The color of the text in the heading can be changed by clicking on the down

arrow on the right of the Color button  to pop up the color control.
Select a color by clicking on one of the color boxes, or click the Other… button
to choose a custom color.

Annotation Tool Default Properties

Editing the default properties of an annotation tool affects subsequent annotations added using the tool. It
does not change the properties of existing annotations.

1. From the Annotation toolbar, select the tool you want to customize, and then select the

Default Properties ( ) toolbar button. If the toolbar button is grayed out, then that
annotation does not have default properties to set.

2. A Default Properties dialog will appear showing the properties that are available to be edited
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for that tool. Shown below is the Default Properties dialog for the text annotation. It is the
only annotation that has Font properties in addition to Line and Fill properties.

3. Change the any desired properties and click the OK button to set the defaults.

Editing Annotation Properties

1. Select the annotation whose properties you want to change.

2. Select the Annotation Properties ( )toolbar button from the Annotation toolbar.

3. The Annotation Properties dialog will appear showing the properties that are available to be
edited for that tool. The tabs shown will depend on the annotation selected. For example, a text
annotation will have a Font tab, but a filled rectangle will not.
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4. If you change a property, the Apply button in the lower right corner will become enabled. By
clicking this button, the changes you have made will be temporarily applied to the annotation on
the page. To keep the changes, click OK. Clicking Cancel will abandon the changes and return
the annotation back to its original state.

  Productivity Tips - Annotation Properties

Use the Enter key to quickly display the properties for the selected annotation.
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Arranging Annotations

You can set alignment, spacing, and sizing options for your annotations. You can nudge annotations to a
precise location, change their order on the page, and group them together for ease of editing.

If the Layout toolbar is not visible, go to the View menu, select Toolbars and then select the Layout
menu item to toggle the toolbar on.

Move annotations using the mouse

1. Select the annotation you want to move. When the mouse is over the selected annotation the

cursor will change from the mouse pointer to the move crosshair  

2. Click and hold the left mouse button while you drag to move the annotation to the desired location.

3. Release the mouse button when you have placed the annotation where you want it.

Move annotations using the keyboard

1. Select the annotation you want to move.

2. Move the annotation using the Left, Right, Up and Down arrow keys. Each key press nudges
the annotation up one pixel. Holding the Shift key down along with the arrow keys will move the
annotation in larger increments.

Aligning annotations

To align annotations, you have to select at least two annotations. The last annotation you select is the 
primary annotation, indicated by the gray handles. The other annotations will have white handles. The
alignment is always performed relative to the primary annotation. See Selecting Annotations for details on
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selecting groups of annotations.

1. Select the annotations you want to align together. Always select the annotation you are aligning
the other annotations to last.

2. From the Layout toolbar, select one of the Align toolbar buttons.

3. All selected annotations will be aligned accordingly to the primary annotation.

Align Top Align Left

Align Middle Align Center

Align Bottom Align Right

Spacing annotations evenly across or down

To evenly space annotations, you have to select at least three annotations. The last annotation you select
is the primary annotation, indicated by the gray handles. The other annotations will have white handles.
See Selecting Annotations for details on selecting groups of annotations.

When spacing annotations across, the annotations will be spaced evenly between the leftmost selected
annotation and the rightmost. When spacing annotations down, the annotations will be spaced evenly
between the topmost selected annotation and the bottommost.

1. Select the annotations you want to align together.

2. From the Layout toolbar, select either Space Across or Space Down operations.

Same Size

Making annotations the same width, height, or size

To make annotations the same height, you have to select at least two annotations. The last annotation
you select is the primary annotation, indicated by the gray handles. The other annotations will have
white handles. The height, width or size adjustment is always performed relative to the primary
annotation. See Selecting Annotations for details on selecting groups of annotations.

1. Select the annotations you want to adjust the size of, and then lastly, select the annotation you are
want the others to match.

2. From the Layout toolbar, select one of the Sizing toolbar buttons. All selected annotations will
be sized accordingly to the primary annotation.
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Same Width

Same Height

Same Size

Nudging annotations to a new position

You can nudge a single annotation or a group of annotations. The annotations can be nudged (moved)
using the Left, Right, Up and Down arrow keys on the keyboard. Each key press nudges the
annotation up one pixel. See Selecting Annotations for details on selecting groups of annotations.

1. Select the annotations you want to nudge.

2. From the Layout toolbar, select one of the Nudge toolbar buttons.

Nudge Up Nudge Down

Nudge Left Nudge Right

Grouping and ungrouping annotations

To group annotations, you have to select at least two annotations. When annotations are grouped
together, they cannot be individually selected. Selecting any one annotation of a group selects the whole
group, and they are treated as a single annotation. Grouped annotations can be moved, ordered or copied
to the clipboard. They cannot be aligned, nudged or sized to one another in the group, but a grouping can
be aligned, nudged or sized with another annotation or group. See Selecting Annotations for details on
selecting groups of annotations.

To ungroup annotations, you have to select a set of grouped annotations. Once annotations are
ungrouped, they can be individually selected, moved, sized, and nudged again. All layout options are
applicable again.

1. Select the annotations you want to group or ungroup.

2. From the Layout toolbar, select the Group toolbar button to group the selected annotations, or
Ungroup to ungroup a set of grouped annotations.

Group Ungroup
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Ordering a group of annotations

Annotations can be ordered, or layered. Ordering annotations dictates which annotation is drawn first,
which next and so on. This is useful if you want your text annotation to be above your filled rectangle. You
can set the order of a single selected annotation, or a group of group selected annotations. See Selecting
Annotations for details on selecting groups of annotations.

1. Select the annotation(s) that you want to change the ordering of.

2. From the Layout toolbar, select one of the Ordering toolbar buttons.

Bring to Front Send to Back

Bring Forward Send Backward
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Application Preferences

This dialog box contains the settings for configuring how PDF Creator Plus itself works. These settings
are saved with the program and will apply to all projects. You can set General, Prompting Defaults,
Printing Defaults and PDF Security preferences forPDF Creator Plus by clicking Edit – Application
Preferences in the application menu.

Application Preferences

Setting General Preferences

Setting Prompting Defaults Preferences

Setting Printing Defaults Preferences

Setting Compression Preferences

Setting Downsampling Preferences

Setting PDF Security Preferences
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General Preferences

Display

Display splash screen on startup - allows you to optionally display the splash screen on startup of
the application.

Display information screen on startup - allows you to optionally display the information screen
when the application is started. This screen is only displays when the application is launched with no
project.

Display page unit as - allows you to specify the units, one of Millimeters, Inches, Centimeter or
Pixels, to use to to display the page size in the application status bar.

Notifications

Prompt on errors - allows you to have the application optionally prompt when an error is returned.

Prompt on warnings - allows you to have the application optionally prompt you when a warning is
returned.
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Prompting Defaults Preferences

On Incoming Document

Allows you to choose what will happen when a print job is run using the PDF Creator Plus print driver.

Display dialog to choose where to add files - allows you to optionally display the dialog for
choosing where to append or insert the new pages or to create new document when new pages are
available from the PDF Creator Plus print driver.

Bring application to the foreground - allows you to specify whether or not bring the PDF Creator
Plus application to the foreground when new pages are available from the PDF Creator Plus print
driver.
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Default Page Action

Set the default action you would like to do each time new pages are available from the PDF Creator
Plus print driver.

Append pages – append the pages to the end of the current page collection.

Create new document – discard any current pages and create a new page collection.

Insert pages before selected page – insert any new pages before the selected page in the current
page collection.

Insert pages after selected page – insert any new pages after the selected page in the current page
collection.
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Printing Defaults Preferences

The options set here are the same options displayed on the Print dialog when a PDF Creator Plus
project is printed.

Page Scaling

Determines how each page is scaling when printed to the selected printer.

Fit to Paper - enlarges or reduces the page to fit the size of the currently selected paper size.

Actual Size - does not scale the page. Any part of the page that does not fit in the printable area of
the currently selected paper size is cropped.

Auto-rotate pages to fit printer page as required

Adjusts the pages orientation to maximize the amount of page printed. If this option is on, the page
will be rotated if rotating the page allows more of the page to fit in the printable area of the currently
selected paper size.

Center page if smaller than printer page

If the page is smaller than the printable area of the currently selected paper size, the contents of the
page will be centered. This will not affect pages that are larger than the printable area.

Shrink page if larger than the printer page

If the page is larger than the printable area of the currently selected paper size, the contents of the
page will be scaled to fit. This gives the same result as Fit to Paper for larger pages. This does not
affect pages that are smaller than the printable area. This option only applies when printing Actual
Size.
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Compression Preferences

The compression method used to storing any images (such as pictures, screenshots, company logos) will
affect the the final size of your files. Compression methods, with the exception of JPEG compression, do
not affect the image quality.

If you are creating PDF files you may need to experiment with the compression methods as well as the 
Downsampling Preferences options to find the best balance between the size of your file and the quality of
the images. Downsampling options are only used in PDF files creation.

If you are creating image files such as TIFF, JPEG or BMP files, the compression options will be applied
as applicable for the output file type. Not all of the compression methods available are valid for all of the
output image formats supported. The following table lists the valid formats for each image type. 

If the selected compression method is not valid for the image format chosen, the method shown in bold is
used instead.

Output Format Color Greyscale Indexed Monochrome

TIFF Images LZW
JPEG
Packbits

LZW
JPEG
Packbits

LZW
JPEG
Packbits

CCITT Group 4
CCITT Group 3 2D
CCITT Group 3 1D
CCITT Modified
Huffman
LZW
Packbits

JPEG Images JPEG JPEG JPEG N/A

BMP Images Uncompressed Packbits Packbits Uncompressed

Image Compression Options

Color Images - allows you to choose the compression method to use to compress color images.
Available compression methods are LZW, JPEG, Packbits, and ZIP.

Greyscale Images - allows you to choose the compression method to use to compress greyscale
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images. Available compression methods are LZW, JPEG, Packbits, and ZIP.

Indexed Images - allows you to choose the compression method to use to compress indexed
images. Available compression methods are LZW, JPEG, Packbits, and ZIP.

Monochrome Images - allows you to choose the compression method to use to compress
monochrome (black and white) images. Available compression methods are CCITT Group 4,
CCITT Group 3 2D, CCITT Group 3 1D, CCITT Modified Huffman, LZW, and
Packbits.

JPEG Image Quality - the slider allows you to set the JPEG compression factor used when
compressing images using the JPEG compression setting. The JPEG compression factor is a number
from lowest quality (0) to highest quality (100). A higher quality compression factor will produce a
larger file with a better quality picture, while a lower  quality compression factor will produce a smaller
file but can degrade the quality of any pictures.
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Downsampling Preferences

Downsampling is only applied to PDF files and can greatly reduce the amount of space it takes to store
the image information in your file. It does this by reducing the dots per inch (DPI) of the image. Images are
made up of bits called pixels and by reducing the number of pixels in the image through downsampling
you reduce the overall size of the file.

Unlike most of the Compression Preferences options, downsampling does have an effect on the quality of
the images in your file. The downsampling DPI can be set any where between 50 and 600 DPI. An image
will only be downsampled if its DPI is higher then the downsampling DPI. If the DPI of the image is less
than the downsampling DPI the image is not changed.

Image Downsampling Options

Reduce color images to - allows you to optionally choose to downsample color images to the dots
per inch selected.

Reduce indexed images to - allows you to optionally choose to downsample color images to the dots
per inch selected.

Reduce greyscale images to - allows you to optionally choose to downsample color images to the
dots per inch selected.

Reduce monochrome images to - allows you to optionally choose to downsample color images to
the dots per inch selected.

For all of the above options, the dots per inch can be set any where between 50 and 600 DPI by
typing the desired level into the edit field, or using the spinbox up/down arrows to the right of each edit
field to set the value.
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PDF Security Preferences

Sets the default security options used to create secure PDF files.

Encryption Level

Sets the encryption level for Adobe® PDF output.

40-bit - can be opened in Acrobat 3.0 and higher

128-bit - can be opened in Acrobat 5.0 and higher. 128-bit a provides stronger encryption , so your
PDF file is more secure.

Allow Users to

Copy text and graphics – text and graphics from the PDF file can be copied to the clipboard and
used in other applications.

Change the document – pages can be added or deleted from the PDF file.

Print the document – the PDF document can be printed.

Add or change comments and form fields – annotations and form fields in the PDF file can be
added, deleted or modified.

Passwords

Password required to open document – allows you to set password for users to open the Adobe
PDF output.

Password required to change document – allows you to set password for users to modify the
Adobe PDF output.
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Appendix

Customizing Application Toolbars

1. Click the View – Customize menu item.

2. From the Toolbars tab on this dialog, you can hide and display the toolbars, turn tooltips on or
off and create new or delete existing toolbars.

 

3. From the Command tab, you can drag buttons onto toolbars.

4. When this dialog is open, you can:

customize toolbars by dragging buttons to new locations on other toolbars

remove a button from a toolbar by clicking and dragging it off the toolbar
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add buttons back using the Command tab to access the individual toolbar buttons

reset the toolbar to its original state by clicking the Reset button

Hiding and showing a toolbar

1. Click the View – Toolbars - desired toolbar menu item.

 - or -

1. Click View – Toolbars – Customize.

2. Enable the checkbox beside the toolbar.

Creating a new toolbar

1. Click View – Toolbars – Customize.

2. Select New…

3. Enter a name for the toolbar.

4. Left - click and drag buttons from the existing toolbars onto your new toolbar, or use the 
Command tab to build your toolbar.

Moving toolbar buttons

1. Click View – Toolbars – Customize.

2. Left - click and drag the toolbar button to the desired location.

Removing toolbar buttons

1. Click View – Toolbars – Customize.

2. Left - click and drag the toolbar button off the toolbar.

Adding toolbar buttons

1. Click View – Toolbars – Customize.

2. Click the Command tab.

3. Select the Category that has the desired button. Left - click and drag the button from the
Buttons section onto the toolbar.
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The tables below provide descriptions for the various menu, keyboard, and toolbar commands found
within PDF Creator Plus.

Command Reference

File Menu Commands

Edit Menu Commands

View Menu Commands

Page Menu Commands

Layout Menu Commands

Annotation Menu Commands

Help Menu Commands

File Menu Commands

Menu Item Toolbar Icon Keyboard Shortcut Description

Create PDF
Ctrl + D

Create a PDF file from
your current PDF
Creator Plus project.

Create TIFF
CTRL + T

Create a TIFF file from
your current PDF
Creator Plus project.

Create JPEG
CTRL + J

Create a JPEG file
from your current PDF
Creator Plus project.

Create Other File

CTRL + F

Create other types of
files such as BMP and
EMF, as well as PDF,
TIFF and JPEG files
from your current PDF
Creator Plus project.

New Project
CTRL + N

Create an new empty
PDF Creator Plus
project.

Open Project
CTRL + O

Open an PDF Creator
Plus project.

Close Project Close the currently
open PDF Creator Plus
project.
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Save Project
CTRL + S

Save the currently
open PDF Creator Plus
project.

Save Project As Save the currently
open PDF Creator Plus
project with a new
name.

Import File
CTRL + I

Import a file into the
current PDF Creator
Plus project

Print
CTRL + P

Prints the PDF Creator
Plus project.

Print Preview Preview the project
before printing.

Print Setup Set the printer
properties for the
project.

Recent Files List Lists recently opened
PDF Creator Plus
projects.

Exit Exit the application.

Edit Menu Commands

Menu Item Toolbar Icon Keyboard Shortcut Description

Undo
CTRL + Z

Undo the previous
annotation action.

Redo
CTRL + Y

Redo the previously-
undone annotation
action.

Cut
CTRL + X

Cuts the currently
selected annotations to
the clipboard.

Copy
CTRL + C

Copies the currently
selected annotations to
the clipboard.

Paste

CTRL + C

Pastes back the
contents of the
clipboard onto the
page.

Delete

DELETE

Deletes the current
selection. This can be
a page or an
annotation on a page.

Select All
CTRL + A

Selects all annotations
on the page.
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Application Preferences Change application
preferences

PDF Creator Plus Printer
Settings

Allows you to modify
PDF Creator Plus
Printer Settings

View Menu Commands

Menu Item Toolbar Icon Keyboard Shortcut Description

One Page View only the current
page.

Thumbnails View only the
thumbnails.

Outline View only the outline.

Page and Thumbnails View both the current
page and the
thumbnail.

Page and Outline View  both the current
page and the outline

Zoom - Zoom In Increases the zoom
level

Zoom - Zoom Out Decreases the zoom
level

Zoom - Zoom to Selected Area Select an area on the
page with the mouse
and zoom into that
area

Zoom - Best Fit Sets the zoom level to
the best fit

Zoom - Fit to Width Sets the zoom level to
fit the width of the page

Zoom - Fit to Height Sets the zoom level to
fit the height of the
page

Zoom - Custom Allows you to set a
custom zoom level

Zoom - 25% Sets the zoom level to
25%

Zoom - 50% Sets the zoom level to
50%

Zoom - 75% Sets the zoom level to
75%

Zoom - 100% Sets the zoom level to
100%
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Zoom - 200% Sets the zoom level to
200%

Zoom - 400% Sets the zoom level to
400%

Toolbars – Standard Show or hide the
Standard toolbar

Toolbars – View Show or hide the View
toolbar

Toolbars - Annotations Show or hide the
Annotations toolbar

Toolbars - Layout Show or hide the
Layout toolbar

Toolbars - Customize Customize the toolbars

Status Bar Show or hide the
status bar

Page Menu Commands

Menu Item Toolbar Icon Keyboard Shortcut Description

Previous Takes you back to the
previous page

Previous Takes you forward to
the next page

First Takes you directly to
the first page

Last Takes you directly to
the last page

Cut Cuts an entire page to
the clipboard

Copy - Page Copies an entire page
to the clipboard

Copy - Range Allows you to copy a
range of pages to a
specified position

Paste - Page - Before Pastes an entire page
from the clipboard
before the current page

Paste - Page - After Pastes an entire page
from the clipboard after
the current page

Paste - Page - Append Pastes an entire page
from the clipboard to
the end of the
document
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Insert Blank - Before Allows you to insert a
blank page before the
current page

Insert Blank - After Allows you to insert a
blank page after the
current page

Insert Blank - Append Allows you to append a
blank page at the end
of the document

Delete - Page Allows you to mark a
page for deletion

Delete - Range Allows you to mark a
range of pages for
deletion

Undelete - Page Allows you to unmark a
page for deletion

Undelete - Range Allows you to unmark a
range of pages for
deletion

Move Range Allows you to move a
range of pages to a
specified position

Rotate - Left Rotates selected page
left 90 degrees

Rotate - Right Rotates selected page
right 90 degrees

Rotate - 180 Rotates selected page
180 degrees

Rotate All - Left Rotates all pages left
90 degrees

Rotate All - Right Rotates all pages right
90 degrees

Rotate All - 180 Rotates all pages 180
degrees

Page Properties Allows you to view the
properties of the
current page

Layout menu commands

Menu Item Toolbar Keyboard Description

Align – Align Top
Allows you to align
selections vertically at
the top

Align – Align Middle
Allows you to align
selections vertically in
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the middle

Align – Align Bottom
Allows you to align
selections vertically at
the bottom

Align – Align Left
Allows you to align
selections horizontally
at the left

Align – Align Center
Allows you to align
selections horizontally
in the center

Align – Align Right
Allows you to align
selections horizontally
at the right

Space Evenly - Across
Allows you to space
selections evenly
across the page

Space Evenly - Down
Allows you to space
selections evenly down
the page

Make Same Size - Width
Allows you to make
selections the same
width

Make Same Size - Height
Allows you to make
selections the same
height

Make Same Size - Both
Allows you to make
selections the same
width and height

Nudge - Up
Allows you to nudge
selections up

Nudge - Down
Allows you to nudge
selections down

Nudge - Left
Allows you to nudge
selections left

Nudge - Right
Allows you to nudge
selections right

Order – Bring to Front
Allows you to move a
selection to the front of
the order

Order – Send to Back
Allows you to move a
selection to the back of
the order

Order – Bring Forward
Allows you to move a
selection forward in the
order

Order – Send Backward
Allows you to move a
selection backward in
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the order

Grouping - Group
Allows you to bind
together selections for
editing as a group

Grouping - Ungroup
Allows you to ungroup
grouped selections

Annotation menu commands

Menu Item Toolbar Keyboard Description

Pan
Drag the page to
reveal hidden areas

Select
Make selections on the
page

Selected Properties ENTER
Edit the properties of
the selected
annotation

Eraser Erase a selected area

Text
Add a text box
annotation

Outline
Add a heading or
bookmark area

Hyperlink Add a hyperlink area

Filled Rectangle Draw a filled rectangle

Hollow Rectangle
Draw a hollow
rectangle

Line Draw a line

Polygon Draw a polygon

Ellipse Draw an ellipse

Polycurve Draw a polycurve

Select Image Clone a selected area

Edit Vertices
Edit the vertices of the
selected annotation

Default Properties

Edit the default
properties of the
selected annotation
tool

Outline Properties
Edit the outline
properties of the
selected annotation
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Hyperlink Properties
Edit the URL
properties of the
selected annotation

Sticky Annotations
Keeps annotation tool
chosen until Selection
tool is chosen again

Help menu commands

Menu Item Toolbar Keyboard Description

Help Topics  F1 View Help topics

User Guide  View the User Guide

Updates & Support  
View support and
update information

License  
Show license
information

About PDF Creator Plus
View application
information
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